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About this Manual
TEMPpoint is a family of temperature measurement instruments that includes the DT9871U, 
DT9871, DT8871U, DT8871, DT9872, and DT8872. This manual describes the DT8871U, 
DT8871, and DT8872 Ethernet LXI (LAN eXtensions for Instrumentation) models. 

VOLTpoint is a family of voltage measurement instruments that includes the DT9873 and 
DT8873. This manual describes the DT8873 LXI model.

MEASURpoint™ a family of mixed temperature and voltage measurement instruments that 
includes the DT9874 and DT8874. This manual describes the DT8874 LXI model.

Note: For information on the DT8875 MEASURpoint LXI instrument, refer to the DT8875 
MEASURpoint LXI Instrument User’s Manual.

For information on the DT8876 MEASURpoint LXI instrument, refer to the DT8876 
MEASURpoint LXI Instrument User’s Manual.

For information on the DT9871U, DT9871, DT9872, DT9873, and DT9874 USB models of 
TEMPpoint, VOLTpoint, and MEASURpoint, refer to the User’s Manual for Standard 
TEMPpoint, VOLTpoint, and MEASURpoint USB Instruments.

The first part of this manual describes how to install and set up your instrument, and verify 
that the instrument is working properly.

The second part of this manual describes the features and capabilities of your instrument 
using the IVI-COM instrument driver software. Troubleshooting information is also provided.

Note: If you are programming the instrument using the IVI-COM driver, refer to the 
DtxMeasurement IVI-COM driver online help for more information.

If you are using Standard Commands for Programmable Instruments (SCPI) to program your 
instrument, refer to the SCPI Programmer’s Manual for MEASURpoint for more information.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for 
using and/or programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument. It is 
assumed that you have some familiarity with thermocouples, RTDs, and/or voltages and that 
you understand your application.
11
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How this Manual is Organized 

This manual is organized as follows:

• Chapter 1, “Overview,” summarizes the major features of the TEMPpoint, VOLTpoint, 
and MEASURpoint instruments, as well as the supported software and accessories.

• Chapter 2, “Preparing to Use the Instrument,” describes how to unpack the instrument, 
check the system requirements, install the software, and view the documentation online.

• Chapter 3, “Setting Up and Installing the Instrument,” describes how to apply power to 
the instrument and connect the instrument to the network. 

• Chapter 4, “Wiring Signals,” describes how to wire signals to the instrument. 

• Chapter 5, “Verifying the Operation of Your Instrument,” describes how to verify the 
operation of the instrument with the instrument’s web interface. 

• Chapter 6, “Principles of Operation,” describes the analog input and digital I/O features 
of the TEMPpoint, VOLTpoint, and MEASURpoint instruments in detail.

• Chapter 7, “Troubleshooting,” provides information that you can use to resolve problems 
with your instrument, should they occur.

• Appendix A, “Specifications,” lists the specifications of the TEMPpoint, VOLTpoint, and 
MEASURpoint instruments.

• Appendix B, “Connector Pin Assignments,” describes the pin assignments of the digital 
I/O connector on the TEMPpoint, VOLTpoint, and MEASURpoint instruments.

• Appendix C, “Configuring Network Settings on Your PC,” describes how to configure the 
network settings of your PC to use Auto-IP or a static IP address.

• Appendix D, “About ISO-Channel Technology,” describes the benefits of ISO-Channel™ 
technology.

• An index completes this manual.

Conventions Used in this Manual

The following conventions are used in this manual:

• Notes provide useful information or information that requires special emphasis, cautions 
provide information to help you avoid losing data or damaging your equipment, and 
warnings provide information to help you avoid catastrophic damage to yourself or your 
equipment.

• Items that you select or type are shown in bold.
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Related Information

Refer to the following documents for more information on using a TEMPpoint, VOLTpoint, or 
MEASURpoint LXI instrument:

• DtxMeasurement IVI-COM Driver online help. This document describes how to use the 
IVI-COM driver to access the capabilities of your instrument. 

The IVI-COM driver works with any development environment that supports COM 
programming, including MATLAB® from The MathWorksTM, Microsoft® Visual 
C#®.NET or Visual Basic®.NET, Agilent® VEE Pro, National Instruments™ LabVIEW™ 
or LabWindows™, and so on.

• QuickDAQ 2103 User’s Manual (UM-24774). This manual describes how to create a 
QuickDAQ application to acquire and analyze data from a TEMPpoint, VOLTpoint, or 
MEASURpoint instrument.

• SCPI Programmer’s Manual for LXI Measurement Instruments. For programmers who want 
to use the SCPI interface to program a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, this document describes the supported SCPI commands and example 
programs for these instruments.

• IVI foundation (www.ivifoundation.org)

• Omega Complete Temperature Measurement Handbook and Encyclopedia® or the Omega 
Engineering web site: http://www.omega.com. Both resources provide valuable information on 
thermocouple types, RTD types, standards, and linearization.

Where To Get Help

Should you run into problems installing or using a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, the Data Translation Technical Support Department is available to provide 
technical assistance. Refer to Chapter 7 for more information. If you are outside the United 
States or Canada, call your local distributor, whose number is listed on our web site 
(www.datatranslation.com). 
13
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Hardware Features
Data Translation provides a number of LXI (Ethernet) instruments to meet your measurement 
needs, including the following:

• TEMPpoint – a family of temperature measurement instruments 

• VOLTpoint – a family of voltage measurement instruments

• MEASURpoint – a family of mixed temperature and voltage measurement instruments

All of these Ethernet instruments are class C devices that comply with LXI version 1.1. 

The following sections summarize the features of the TEMPpoint, VOLTpoint, and 
MEASURpoint LXI instruments.

TEMPpoint Features

TEMPpoint instruments include the following models: DT8871U, DT8871, and DT8872. 
Figure 1 shows a DT8871U instrument.

Figure 1: TEMPpoint Instrument

The key features of TEMPpoint instruments are as follows: 

• DT8871U and DT8871:

− Configurable analog input channels for thermocouple or differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− One CJC (cold junction compensation) input for each thermocouple channel



Overview
− B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically 
linearizes the measurements and returns the data as a 32-bit, floating-point 
temperature values

− Input range of ±0.075 V for the DT8871U (with 0.25 μV RMS A/D noise using no 
software filtering) and ±1.25 V for the DT8871 (with 5 μV RMS A/D noise using no 
software filtering) 

− Break-detection circuitry to detect open thermocouple inputs

• DT8872:

− Configurable analog input channels for RTDs and differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− 100 Ω, 500 Ω, and 1000 Ω platinum RTD types supported using alpha curves of 0.00385 
(European) or 0.00392 (American)

− 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the 
measurements and returns the data as 32-bit, floating-point temperature, resistance, or 
voltage values

− Input range of ±1.25 V 

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity

• Throughput rate of up to 10 Samples/s for all channels.

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 23 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC
17
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VOLTpoint Features

Figure 2 shows a VOLTpoint instrument.

Figure 2: VOLTpoint Instrument

The key features of VOLTpoint (DT8873) instruments are as follows: 

• Direct connection of analog input channels for differential voltage inputs; removable 
screw terminal blocks for each channel for quick wiring

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity

• Software-selectable input range of ±10 V, ±100 V, or ±400 V per channel

• Throughput rate of up to 10 Samples/s for all channels

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 23 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC
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MEASURpoint Features

The standard MEASURpoint (DT8874) instrument provides 16 thermocouple channels, 16 
RTD channels, and 16 voltage channels. Figure 3 shows a MEASURpoint instrument.

Figure 3: MEASURpoint Instrument

The key features of MEASURpoint (DT8874) instruments are as follows: 

• Analog Input Channels 0 to 15:

− Configurable channels for thermocouple or differential voltage inputs; easy-access 
jacks for each channel for quick wiring

− One CJC (cold junction compensation) input for each thermocouple channel

− B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically 
linearizes the measurements and returns the data as a 32-bit, floating-point 
temperature values

− Input range of ±0.075 V (with 0.25 μV RMS A/D noise using no software filtering) 

− Break-detection circuitry to detect open thermocouple inputs
19
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• Analog Input Channels 16 to 31:

− Configurable analog input channels for RTDs and differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− 100 Ω, 500 Ω, and 1000 Ω platinum RTD types supported using alpha curves of 0.00385 
(European) or 0.00392 (American)

− 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the 
measurements and returns the data as 32-bit, floating-point temperature, resistance, or 
voltage values

− Input range of ±1.25 V 

• Analog Input Channels 31 to 48:

− Direct connection of analog input channels for differential voltage inputs; removable 
screw terminal blocks for each channel for quick wiring

− Software-selectable input range of ±10 V, ±100 V, or ±400 V per channel

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity

• Throughput rate of up to 10 Samples/s for all channels

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 23 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC
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Supported Software
The following software is available for use with the TEMPpoint, VOLTpoint, and 
MEASURpoint instruments:

• Eureka Discovery Utility – This utility helps you locate or "discover" all LXI (Ethernet) 
instruments that are connected to your system and provides the following information 
about your instrument: the IP address, manufacturer, model number, serial number, and 
version of the firmware that is running on your instrument. In addition, you can use this 
utility to configure Windows firewall settings and update the firmware for your Data 
Translation LXI instrument.

• Instrument Web Interface – This built-in interface, described in Chapter 5, allows you to 
verify the operation of your instrument and perform basic functions with Internet 
Explorer and no additional software. Using it, you can configure your instrument, control 
output signals, measure input signals, and save results to disk.

• QuickDAQ Base Version – The base version of QuickDAQ is free-of-charge and allows 
you to acquire and analyze data from all Data Translation USB and Ethernet devices, 
except the DT9841 Series, DT9817, DT9835, and DT9853/54. Using the base version of 
QuickDAQ, you can perform the following functions:

− Discover and select your devices.

− Configure all input channel settings for the attached sensors.

− Load/save multiple hardware configurations.

− Generate output stimuli (fixed waveforms, swept sine waves, or noise signals).

− On each supported data acquisition device, acquire data from all channels supported 
in the input channel list.

− Choose to acquire data continuously or for a specified duration.

− Choose software or triggered acquisition.

− Log acquired data to disk in an .hpf file.

− Display acquired data during acquisition in either a digital display using the Channel 
Display window or as a waveform in the Channel Plot window.

− Choose linear or logarithmic scaling for the horizontal and vertical axes.

− View statistics about the acquired data, including the minimum, maximum, delta, and 
mean values and the standard deviation in the Statistics window.

− Export time data to a .csv or .txt file; you can open the recorded data in Microsoft 
Excel® for further analysis.

− Read a previously recorded .hpf data file. 

− Customize many aspects of the acquisition, display, and recording functions to suit 
your needs, including the acquisition duration, sampling frequency, trigger settings, 
filter type, and temperature units to use.
21
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• QuickDAQ FFT Analysis Option – When enabled with a purchased license key, the 
QuickDAQ FFT Analysis option includes all the features of the QuickDAQ Base version 
plus basic FFT analysis features, including the following:

− The ability to switch between the Data Logger time-based interface and the FFT 
Analyzer block/average-based interface.

− Supports software, freerun, or triggered acquisition with accept and reject controls for 
impact testing applications.

− Allows you to perform single-channel FFT (Fast Fourier Transform) operations, 
including AutoSpectrum, Spectrum, and Power Spectral Density, on the acquired 
analog input data. You can configure a number of parameters for the FFT, including 
the FFT size, windowing type, averaging type, integration type, and so on.

− Allows you to display frequency-domain data as amplitude or phase.

− Supports dB or linear scaling with RMS (root mean squared), peak, and peak-to-peak 
scaling options

− Supports linear or exponential averaging with RMS, vector, and peak hold averaging 
options.

− Supports windowed time channels.

− Supports the following response window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, and Flat top.

− Supports the ability to lock the waveform output to the analysis frame time.

− Allows you to configure and view dynamic performance statistics, including the input 
below full-scale (IBF), total harmonic distortion (THD), spurious free dynamic range 
(SFDR), signal-to-noise and distortion ratio (SINAD), signal-to-noise ratio (SNR), and 
the effective number of bits (ENOB), for selected time-domain channels in the Statistics 
window.

− Supports digital IIR (infinite impulse response) filters.

• QuickDAQ Advanced FFT Analysis Option – When enabled with a purchased software 
license, the QuickDAQ Advanced FFT Analysis option includes all the features of the 
QuickDAQ Base version with the FFT Analysis option plus advanced FFT analysis 
features, including the following:

− Allows you to designate a channel as a Reference or Response channel.

− Allows you to perform two-channel FFT analysis functions, including Frequency 
Response Functions (Inertance, Mobility, Compliance, Apparent Mass, Impedance, 
Dynamic Stiffness, or custom FRF) with H1, H2, or H3 estimator types, 
Cross-Spectrum, Cross Power Spectral Density, Coherence, and Coherent Output 
Power.

− Supports the Exponential response window type.

− Supports the following reference window types: Hanning, Hamming, Bartlett, 
Blackman, Blackman Harris, FlatTop, Exponential, Force, and Cosine Taper windows.

− Supports real, imaginary, and Nyquist display functions.

− Allows you to save data in the .uff file format.
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• DtxMeasurement IVI-COM driver – This driver provides access to the instrument’s 
functions through a COM server. The IVI-COM driver works in any 32-bit development 
environment that supports COM programming, including MATLAB, Visual Basic.NET, 
Visual C#.NET, Agilent VEE Pro, LabVIEW, LabWindows, and others.

• SCPI commands – Use SCPI commands to program TEMPpoint, VOLTpoint, or 
MEASURpoint LXI instruments. Refer to the SCPI Programmer’s Manual for LXI 
Measurement Instruments for information on the supported SCPI commands and example 
programs.

• Measurement Instrument Calibration Utility – Users can calibrate a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument in the field using precise calibration equipment 
and the Measurement Instrument Calibration Utility. Since each instrument consists of up 
to 48 individual channels, great care must be taken to ensure that proper warm-up times 
are followed and precise calibration equipment is used.

The calibration utility ships with a comprehensive help file that describes the required 
equipment and calibration procedure, including warm-up times, for each instrument. 

The calibration utility allows you to revert to the factory calibration for any or all 
channels, or revert back to the last user calibration values, if desired. In addition, this 
utility generates a report that lists the starting and ending calibration values for each 
channel, allowing traceability.

Refer to the Data Translation web site (www.datatranslation.com) for information about 
selecting the right software package for your needs.
23
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Accessories
The following optional accessories are available for TEMPpoint, VOLTpoint, or 
MEASURpoint instruments: 

• STP37 screw terminal panel – The STP37, shown in Figure 4, permits easy screw terminal 
connections for accessing the digital I/O signals of a TEMPpoint, VOLTpoint, or 
MEASURpoint instrument. 

Figure 4: STP37 Screw Terminal Panel

• EP333 cable – The EP333, shown in Figure 5, is a 2-meter shielded cable with two 37-pin 
connectors that connects the STP37 screw terminal panel to the digital I/O connector of 
the instrument.

Figure 5: STP37 Screw Terminal Panel

• EP373 Single Rack-mount Kit – Mounts one TEMPpoint, VOLTpoint, or MEASURpoint 
instrument in a rack. 

• EP374 Dual Rack-mount Kit – Mounts two TEMPpoint, VOLTpoint, or MEASURpoint 
instruments side-by-side in a rack. 
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Getting Started Procedure
The flow diagram shown in Figure 6 illustrates the steps needed to get started using a 
TEMPpoint, VOLTpoint, or MEASURpoint instrument. This diagram is repeated in each 
Getting Started chapter; the shaded area in the diagram shows you where you are in the 
getting started procedure. 

Figure 6: Getting Started Flow Diagram

Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals 
(see Chapter 4 starting on page 47)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 71)

Prepare to Use the Instrument
(see Chapter 2 starting on page 29)
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Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals
(see Chapter 4 starting on page 47)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 71)

Prepare to Use the Instrument
(this chapter)



Preparing to Use the Instrument
Unpacking
Open the shipping box and verify that the following items are present:

• TEMPpoint, VOLTpoint, or MEASURpoint instrument

• EP372 Ethernet cable

• EP361 +5V power supply and cable

• MEASURpoint Software CD-ROM 

• For DT8872, DT8873, and DT8874 instruments, a bag of pluggable screw terminable 
blocks and a screwdriver.

If an item is missing or damaged, contact Data Translation. If you are in the United States, call 
the Customer Service Department at (508) 481-3700, ext. 1323. An application engineer will 
guide you through the appropriate steps for replacing missing or damaged items. If you are 
located outside the United States, call your local distributor, listed on Data Translation’s web 
site (www.datatranslation.com).
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Checking the System Requirements 
For reliable operation, ensure that your computer meets the following system requirements: 

• Processor: Pentium 4/M or equivalent

• RAM: 1 GB

• Screen Resolution: 1024 x 768 pixels

• Disk Space: 4 GB

• Ethernet port

• CD-ROM drive

• Administrator privileges for software installation

• For access to the instrument web interface:

− Java Version 6, Update 5 or greater

− Internet Explorer 6.0 or 7.0 web browser 

Refer to page 73 for more information on installing Java and configuring your browser 
settings

• Acrobat Reader 5.0 or later for viewing documentation



Preparing to Use the Instrument
Installing the Software
This section describes how to install the software you need to use your TEMPpoint, 
VOLTpoint, or MEASURpoint instrument.

Prerequisite Software

No prerequisite software is required if you are using a single client to access a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument on the LXI bus, or if you are managing how 
multiple clients concurrently access the instrument on the LXI bus. (In these case, your 
application can use sockets to communicate with the instrument.)

If, however, you want multiple clients to access your instrument on the LXI bus, and you want 
to "lock" access to the instrument so that one client cannot change the configuration of the 
instrument that another client is accessing, you need to install VISA; we recommend either 
Agilent VISA or NI-VISA from National Instruments. You can then use the VISA methods 
viLock/viUnlock to prevent other clients from accessing the instrument.

To install Agilent VISA, do the following:

1. Go to www.agilent.com, enter IO Libraries Suite in the search field, and select Agilent 
IO Libraries Suite 15.0 from the search results.

2. Follow the instructions on Agilent’s web site to download and install the Agilent IO 
Libraries, which include VISA support, VISA COM support, and the Agilent Connection 
Expert tool.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with 
the MEASURpoint software to locate your LXI instrument on the network (see page 79 for 
more information). 

Installation Instructions

You can install all the software for your instrument either from the web (at 
http://www.datatranslation.com/cd/measurpoint) or from the MEASURpoint Software CD 
that is shipped with the instrument. To ensure that you get the latest updates, it is 
recommended that you install the software from the web.

The installation program guides you through the installation process.
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Viewing the Documentation

Note: To view the documentation, you must have Adobe Reader 5.0 or greater installed on 
your system. 

You can access the documentation for your instrument from the Windows Start menu as 
follows:

• For documentation about the TEMPpoint, VOLTpoint, or MEASURpoint instrument, click 
Programs -> Data Translation, Inc -> Hardware Documentation -> Measurement User’s 
Manual for LXI Instruments.

• For documentation on the Eureka Discovery Utility, click Programs -> Data Translation, 
Inc -> Instrument Support -> Eureka LXI Instrument Discovery.

• For documentation on the QuickDAQ application, click Programs -> Data Translation, 
Inc -> QuickDAQ 2014 -> QuickDAQ User’s Manual

• For documentation on the DtxMeasurement IVI-COM driver, click Programs -> IVI -> 
DtxMeasurement -> Documentation.

• For documentation about SCPI support, click Programs -> Data Translation, Inc -> 
Measurement SCPI Support ->SCPI Programmer’s Manual for Measurement.

The following may be helpful when using Adobe Reader: 

• To navigate to a specific section of the document, click a heading from the table of contents 
on the left side of the document.

• Within the document, click the text shown in blue to jump to the appropriate reference 
(the pointer changes from a hand to an index finger).

• To go back to the page from which the jump was made, click the right mouse button and 
Go Back, or from the main menu, click Document, and then Go Back.

• To increase or decrease the size of the displayed document, from the main menu, click 
View, and then Zoom.

• By default, Adobe Reader smooths text and monochrome images, sometimes resulting in 
blurry images. If you wish, you can turn smoothing off by clicking File, and then 
Preferences/General, and unchecking Smooth Text and Images. 
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Note: Your TEMPpoint, VOLTpoint, and MEASURpoint instruments are factory-calibrated. 
Thereafter, yearly recalibration is recommended. Refer to page 110 for more information on 
calibration.

Set Up and Install the Instrument
(this chapter)

Wire Signals
(see Chapter 4 starting on page 47)

Prepare to Use the Instrument
(see Chapter 2 starting on page 29)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 71)
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Connecting the Instrument to the LAN
Figure 7 shows the LAN (RJ45) connector on the rear of the instrument that is used to connect 
your instrument to the LAN (Local Area Network).

Figure 7: LAN Connector on the Rear of the Instrument

This section describes how to connect your instrument to the LAN. Two connection schemes 
are shown:

• Site LAN connections, described on this page

• Private LAN connections, described on page 39

Note: It is recommended that you consult with your network administrator to ensure that 
all network security, performance, and reliability issues are considered when using 
connecting instruments to the LAN.

LAN 
Connector
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Connecting to a Site LAN

A site LAN is useful in applications that require access by many users or access by users at 
distributed sites. In this connection scheme, a DHCP (Dynamic Host Configuration Protocol) 
server is used to assign an IP address to the instrument.

Figure 8 shows a typical site LAN connections using a dedicated Ethernet hub, switch, or 
router. Figure 9 shows typical site LAN connections without using a dedicated Ethernet hub, 
switch, or router.

Note: Use standard LAN cables for network connections. TEMPpoint, VOLTpoint, and 
MEASURpoint instruments ship with a standard LAN cable (EP372) for connecting to the 
LAN (RJ45) connector on the rear panel of the instrument.

Figure 8: Typical Site LAN Connections using a Hub, Switch, or Router
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Figure 9: Typical Site LAN Connections Without Using a Hub, Switch, or Router

Connecting to a Private LAN

A private LAN (or subnet) generally involves the direct connection of the instruments to the 
computer, and may include Ethernet hubs or switches. Access to the instruments is limited to 
users that are directly connected to the private LAN; therefore, security, performance, and 
reliably are generally better on a private LAN than on a site LAN.

In this connection scheme, the DHCP (Dynamic Host Configuration Protocol) server is 
typically not available; therefore, Auto-IP is used to assign an IP address to the instrument.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, as described on Appendix C starting on 
page 149.

Connecting Using a Hub or Switch

Figure 10 shows a typical connection scheme when connecting TEMPpoint, VOLTpoint, or 
MEASURpoint instruments to a private LAN using a dedicated Ethernet hub or switch. 

Note: Use standard LAN cables for network connections. The instrument ships with a 
standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear panel of 
the instrument.

Computer

+5 V Power
Supply

To Site LAN

To Site LAN

TEMPpoint, 
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MEASURpoint
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Figure 10: Typical Private LAN Connections using a Hub or Switch

Connecting Directly to a Computer

Optionally, you can connect the TEMPpoint, VOLTpoint, or MEASURpoint instrument 
directly to your computer, creating an ad hoc network, as shown in Figure 11. Be aware that 
the time and date settings of the instrument will not be updated using this connection method. 
Therefore, this connection scheme is generally recommended for quick set up and verification 
only.

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments do not support the 
Auto-MDIX function; therefore, use a crossover cable rather than a standard LAN cable to 
connect your instrument unless your computer has enabled the Auto-MDIX function. 

Figure 11: Typical Private LAN Connections when Connecting Directly to a Computer
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Applying Power
TEMPpoint, VOLTpoint, and MEASURpoint instruments are shipped with an EP361 +5V 
power supply and cable. To apply power to the instrument, do the following: 

1. Connect the +5 V power supply to the power connector on the rear panel of the 
instrument. Refer to Figure 12.

Figure 12: Attaching a +5 V Power Supply to the Instrument

2. Plug the power supply into a wall outlet. 

Note: For proper grounding of your measurement instrument, ensure that you use the 
power supply and cable (EP361) that is provided with the instrument and that you use all 
three prongs of the cable when connecting it to your wall outlet.

3. Press the Power switch on the rear panel of the instrument, shown in Figure 12, to turn on 
the instrument.
The Power LED on the front panel lights to indicate that power is on.

EP361 +5 V 
Power Supply

Power 
Switch
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Figure 13 shows the location of the LEDs on the front panel of the instrument; a 
MEASURpoint instrument is shown in this example. 

Figure 13: LEDs on the Front Panel of the Instrument

Power LED LAN LED
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Getting an IP Address and Host Name
Once your instrument is connected to the LAN and powered on, the instrument automatically 
requests an Ethernet address from a DHCP (Dynamic Host Configuration Protocol) server, if 
available, and a host name from a DNS (Dynamic Domain Name Service) server, if available. 

If these services are not available on the LAN, the instrument uses Auto-IP to set up its 
TCP/IP configuration. In this case, the IP address is in the range of 169.254.0.0 to 
169.254.255.255 with a subnet mask of 255.255.0.0.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, then configure your instrument to use a 
static IP address, as described in Appendix C starting on page 149.

You can use the instrument’s web interface, described in Chapter 5 starting on page 71, to see 
the IP address and host name that is assigned to your instrument. 

Notes: When programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument, you 
access the instrument through its address string, which consists of an IP address or host 
name, such as TCPIP0::192.43.218.69::inst0::INSTR or TCPIP0::192.43.218.69::SOCKET. If a 
host name was returned by the DNS server, you can also address the instrument using its 
host name, such as TCPIP0::arrakis.datx.com::inst0::INSTR.

For IVI-COM programmers, you can also assign a VISA alias to the instrument. For example, 
rather than addressing the instrument as TCPIP0::192.43.218.69::inst0::INSTR, you can a 
VISA alias, such as TEMPpoint1, instead. See your VISA documentation for more 
information on VISA resource strings and creating VISA aliases.
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Determining Ethernet Activity 
You can use the ENet Link and ENet Activity LEDs on the rear of the instrument, shown in 
Figure 14, with the LAN LED on the front of the instrument, shown in Figure 13, to determine 
the Ethernet activity on your instrument. Table 1 describes the meaning of these LEDs.

Figure 14: Rear Panel of the Instrument

Table 1: Using LEDs to Determine Ethernet Activity 

LEDs Color Description

LAN LED 
(on front panel)

Solid Green Instrument has valid IP address.

Blinking Green Instrument identified using the Web interface; see page 79 
for more information.

Red If the Ethernet link is operational, the instrument does not 
have a valid IP address. 

Otherwise, the Ethernet link is not operational.

USB LED (not used on this instrument)
LMT LED
OPN LED

ENet Link
LED

ENet Activity
LED

Reset Pin
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ENet Link LED
(on rear panel)

Yellow Ethernet link operational.

Off Ethernet link not operational.

ENet Activity LED
(on rear panel)

Green Network traffic detected.

Off No network traffic detected.

Table 1: Using LEDs to Determine Ethernet Activity  (cont.)

LEDs Color Description
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Resetting the Instrument
If needed, you can restore the default configuration of your instrument by pressing the Reset 
pin on the rear panel of the instrument, shown in Figure 14 on page 44, until the LAN LED on 
the front panel turns off (which takes approximately 5 seconds), and then releasing the Reset 
pin.

The instrument reboots automatically using the factory-default LAN configuration (DHCP 
and auto-IP enabled); this process typically takes up to 40 seconds to complete. This forces the 
instrument to re-acquire an IP address from the DHCP server, or if that fails, to use Auto-IP to 
get an IP address.

Note: The default configuration overwrites any changes that you have made to the LAN 
configuration (IP address and password) using the instrument’s web interface. Refer to page 
83 for information on the default values that are used when the instrument is reset.

The calibration parameters are not affected by the reset.
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Wiring Signals
General Wiring Recommendations
Keep the following recommendations in mind when wiring signals to a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument:

• Separate power and signal lines by using physically different wiring paths or conduits.

• To avoid noise, do not locate the instrument and cabling next to sources that produce high 
electromagnetic fields, such as large electric motors, power lines, solenoids, and electric 
arcs, unless the signals are enclosed in a mumetal shield.

• Locate the instrument’s front panel as far away as possible from sources of high or low 
temperatures or strong air currents, such as fans. 

• Prevent electrostatic discharge to the I/O while the instrument is operational.

• When wiring thermocouples, select an appropriate wire length and gauge for each 
thermocouple; in general, use the shortest wire length and largest gauge for the 
application to yield best results. 

• Use shielded wire for maximum rejection of electrical interference.
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Warm-Up Time
For accurate thermocouple measurements, MEASURpoint instruments require a warm-up 
time of 1 hour for the analog circuitry to stabilize.

For accurate RTD measurements, ensure that your RTD sensors and external calibration 
resistors warm up for 1 minute after the MEASURpoint instrument has been warmed up for 1 
hour.
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Connecting Thermocouple Inputs
The DT8871U, DT8871, and DT8874 instruments contain thermocouple jacks for connecting 
thermocouple inputs. 

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.

Internally, these signals are connected in differential mode. You can mix and match the 
following thermocouple types across channels: B, E, J, K, N, R, S, and/or T.

Each thermocouple input jack is polarized and accepts a mating plug in the appropriate 
orientation. Table 2 lists the color designations for the + and – polarities of the supported 
thermocouple types for both the ANSI (American) and IEC (International) standards. 

For more information on thermocouple standards, refer to the following web site: 
http://www.omega.com/thermocouples.html.

Table 2: Thermocouple Color Designation Standards 

Thermocouple 
Standard

Thermocouple 
Type

Wire Color Coding
+ Polarity

Wire Color Coding
– Polarity

ANSI Type J White Red

Type K Yellow Red

Type T Blue Red

Type E Violet Red

Type S Black Red

Type R Black Red

Type B Gray Red

Type N Orange Red

IEC Type J Black White

Type K Green White

Type T Brown White

Type E Violet White

Type S Orange White

Type R Orange White

Type B Gray White

Type N Pink White
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Figure 15 shows how to connect a thermocouple input to a thermocouple channel.

 

Figure 15: Connecting Thermocouple Inputs

CAUTION:

When connecting inputs to the thermocouple connectors on a 
MEASURpoint or TEMPpoint instrument, it is highly recommended 
that you use only original Omega thermocouple plugs (SMPW), as 
connectors from other suppliers may not be equivalent mechanically. 
Refer to page 142 for more information on the connectors.

If you use connectors from suppliers other than Omega, there is a 
risk that you may mechanically damage the thermocouple 
connectors on the MEASURpoint or TEMPpoint instrument.

Thermocouple 
Channels

Thermocouple Input

– +

– +

Omega Plug (SMPW)
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Connecting RTD Inputs
Each DT8872 and DT8874 contains pluggable screw terminals for connecting RTD inputs. 
Internally, these signals are connected in differential mode.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

Figure 16 shows the numbering of the screw terminal blocks for RTD connections.

 

Figure 16: Screw Terminal Block Numbering for RTD Connections
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Note: To make wiring easier, use the supplied screwdriver to attach your signals to the 
screw terminal blocks. When you are finished, plug the screw terminal block into the screw 
terminal header that corresponds to the channel to which you are wiring.

The DT8872 supplies each RTD channel with 425 μA of excitation current to prevent 
self-heating. The resistance of the RTD circuit increases gradually, repeatably, and linearly 
with temperature. As the resistance increases, the voltage drop across the RTD also increases. 
The DT8872 reads this voltage drop and automatically converts the voltage to the appropriate 
temperature based on the RTD type. 

The DT8872 and DT8874 support Pt100 (100 Ω Platinum), Pt500 (500 Ω Platinum), and Pt1000 
(1000 Ω Platinum) RTD types using Alpha coefficients of 0.00385 and 0.00392; you can mix 
and match RTD types across RTD channels. Refer to the following web site for more 
information on RTD types: http://www.omega.com.

To connect an RTD input, you can use a 4-wire, 3-wire, or 2-wire connection scheme, 
described in the following subsections. For the best accuracy, use 4-wire RTD connections; this 
connection scheme enables Kelvin sensing to minimize errors due to lead wire resistance. 

4-Wire RTD Connections

The 4-wire configuration offers the best accuracy with long connection wires, compared to the 
3- and 2-wire configurations. The 4-wire connection scheme eliminates errors due to lead wire 
resistance (RL) and thermal heating. Wire impedance of up to 100 Ω anywhere in the hookup 
is automatically cancelled as long as the sense wires are connected.

Figure 17 shows a 4-wire RTD connection.

 

Figure 17: 4-Wire RTD Connection
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3-Wire RTD Connections

The 3-wire configuration eliminates one wire from the 4-wire RTD connection. Lead wire 
resistance (RL) errors in the return wire from –Sense may be introduced unless the voltage 
drop is essentially equal and opposite to the voltage drop across +Sense.

Figure 18 shows a 3-wire RTD connection. 

 

Figure 18: 3-Wire RTD Connection

2-Wire RTD Connections

The 2-wire configuration is the least accurate of the RTD wiring configurations because the 
lead wire resistance (RL) and its variation with temperature contribute significant 
measurement errors, particularly if the lead wire is long. If you decide to use the 2-wire 
connection scheme, ensure that you use short lead wire connections.

For example, if the lead resistance is 0.5 Ω in each wire, the lead resistance adds a 1 Ω of error 
to the resistance measurement. Using a 100 Ω RTD (Pt100) with a 0.00385/°C European curve 
coefficient, the resistance represents an initial error of 1 Ω /(0.385Ω /°C) or 2.6°C. Since the 
lead wire resistance changes with ambient temperature, additional errors are also introduced 
in the measurement.

RTD Channel

RTD

425 μA
Current

– Sense +Sense

Return

RL

124 3

*RL is lead wire resistance.
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Figure 19 shows a 2-wire RTD connection. 

 

Figure 19: 2-Wire RTD Connection
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Connecting Voltage Inputs
The way you connect voltage inputs depends on the channel type you are using. This section 
describes how to connect voltage inputs to thermocouple input channels, RTD input channels, 
and voltage input channels.

Connecting Voltage Inputs to Thermocouple Channels

Figure 20 shows how to connect a differential voltage input to a thermocouple input channel 
on the DT8871U, DT8871, or DT8874 instrument.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.
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Figure 20: Connecting Voltage Inputs to a Thermocouple Channel
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Connecting Voltage Inputs to RTD Channels

Figure 21 shows how to connect a voltage input to an RTD channel on a DT8872 or DT8874 
instrument.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

 

Figure 21: Connecting Voltage Inputs to an RTD Channel

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs. 

For best accuracy when connecting voltage inputs, use twisted-pair wires with a dead-ended 
shield connected to pin 4 of the screw terminal block.
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124 3

Shield
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Connecting Voltage Inputs to Voltage Channels

Each DT8873 and DT8874 contains pluggable screw terminals for connecting voltage inputs. 

Note: On the standard DT8874 instrument, channels 32 to 47 correspond to the voltage input 
channels.

Figure 22 shows the numbering of the screw terminal blocks for voltage connections.

 

Figure 22: Screw Terminal Block Numbering for Voltage Connections
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Note: To make wiring easier, use the supplied screwdriver to attach your signals to the 
screw terminal block. When you are finished, plug the screw terminal block into the screw 
terminal header that corresponds to the channel to which you are wiring.

Figure 23 shows how to connect voltage inputs to the DT8873 and DT8874.

 

Figure 23: Connecting Voltage Inputs

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs. 

Note: For best accuracy when connecting voltage inputs, use twisted-pair wires with a 
dead-ended shield connected to pin 4 of the screw terminal block.
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124 3

Shield

*Pin 2 is no connect
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Connecting Current Loop Inputs
In some applications, such as solar cell, fuel cell, and car battery testing applications, you may 
want to accurately sense and measure current in a high voltage loop.

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide channel-to-channel 
isolation of ±500 V, meaning that each input can be referenced to ±500 V.

The way you connect current loop inputs depends on the channel type you are using. This 
section describes how to connect current loop inputs to thermocouple input channels, RTD 
input channels, and voltage input channels.

Connecting Current Loop Inputs to Thermocouple Channels

Thermocouple input channels on the DT8871U and DT8874 have an input range of ±0.075 V. 
Therefore, you can use a 1 Ω series resistor to measure ±0.075 A. Similarly, you can use a 0.1 Ω 
series resistor to measure ±0.75 A. 

Thermocouple input channels on the DT8871 have an input range of ±1.25 V. Therefore, you 
can use a 1 Ω series resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω series resistor to 
measure ±12.5 A or a 10 Ω series resistor to measure ±0.125 A. 

Figure 24 shows how to wire your signals to measure a current loop. In this example, the input 
is referenced to ±80 V.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.
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Figure 24: Connecting Current Loop Inputs to Thermocouple Channels

1 Ω series resistor

80 VCircuit+

+–

+

–

Use a 1 Ω series resistor to convert current to voltage.

For thermocouple channels on the DT8871U and DT8874, 1 Ω = 0.075 A = 0.075 V.
For thermocouple channels on the DT8871, 1 Ω = 1.25 A = 1.25 V.

Thermocouple 
Channels
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Connecting Current Loop Inputs to RTD Channels

RTD channels on the DT8872 and DT8874 instruments have an input range of ±1.25 V. 
Therefore, you can use a 1 Ω shunt resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω 
shunt resistor to measure ±12.5 A or a 10 Ω shunt resistor to measure ±0.125 A.

Figure 25 shows how to wire your signals to measure a current loop. In this example, the input 
is referenced to ±80 V.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

Figure 25: Connecting Current Loop Inputs to RTD Channels

1 Ω shunt resistor

Use a 1 Ω shunt resistor to convert current to voltage: 1 Ω = 1.25 A = 1.25 V. 

80 VCircuit+
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RTD Channel

– Sense +Sense
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Shield
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Connecting Current Loop Inputs to Voltage Channels

Voltage input channels on the DT8873 and DT8874 instruments have an input range of ±10 V, 
±100 V, or ±400 V. You select the input range for each channel using software.

Note: On older versions of the instrument, the input range was fixed and depended on the 
model you purchased. 

With the 24-bit A/D converter, high current, high side current shunts can be used for 
resolutions of less than 0.01 A on a 100 A range. 

Typical Shunts:

• Vishay WSMS5515
.2 mΩ − 2 Ω − 100 Α − 20 μV 

• Vishay CSM2512S
10 mΩ − 1 Ω − 10 Α − 100 μV

• Deltec MUB-500-50
.1 mΩ − 25 Ω − 500 Α − 50 μV 

Note: The resolution is ±2 mV on a ±100 V range and ±0.3 mV on the ±10 V range. Since the 
resolution of the ±400 V range is ±8 mV, using current loop inputs with this range is 
impractical in most applications. 

On the standard DT8874 instrument, channels 32 to 47 correspond to the voltage input 
channels.

Figure 26 shows an example of wiring signals to measure ±20 mA using the ±10 V input 
range. 
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Figure 26: Connecting a Current Loop Input to a Voltage Channel to Measure ±20 mA

250 Ω
shunt resistor 28 V (can be up to ±500 V)±20 mA 

Load

+

–

Voltage Channel

– Sense +Sense

124 3

Shield

In this example, the input range is ±10 V.
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Connecting Digital I/O Signals
To make digital I/O connections easier, you can use the optional STP37 screw terminal panel 
and EP333 cable with your TEMPpoint, VOLTpoint, or MEASURpoint instrument. Connect 
the STP37 to the digital I/O connector of the instrument as shown in Figure 27:

Figure 27: Connecting the Instrument to the STP37

Figure 28 shows the layout of the STP37 screw terminal panel and lists the assignments of 
each screw terminal.

EP333 Cable

STP37 Screw Terminal Panel

Digital I/O 
Connector
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Figure 28: STP37 Screw Terminal Panel

Connecting Digital Input Signals

Figure 29 shows how to connect digital input signals (lines 0 and 1, in this case) to the digital 
I/O connector on the TEMPpoint, VOLTpoint, or MEASURpoint instrument. 

Figure 29: Connecting Digital Inputs
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Wiring Signals
Connecting Digital Output Signals

The digital output lines of a TEMPpoint, VOLTpoint, or MEASURpoint instrument act as 
solid-state relays. The customer-supplied signal can be ±30 V at up to 400 mA (peak) AC or 
DC. 

You can use the digital output lines of the instrument to control solid-state or mechanical 
relays or high-current electric motors. Figure 30 shows how to connect digital output signals 
to line 0 of the instrument to control a motor relay.

Figure 30: Switching up to 30 V at 400 mA

Digital Out 0

Digital Out 0pin 10

120 V AC
or 240 V AC

Relay

Motor

10 A 
Fuse

NeutralHot

30V DC @ 400 mA

+ *–
pin 29

Instrument
Digital I/O Connector

*Output can switch AC or DC.

Controlled by
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You can verify the operation of your instrument using the instrument’s web interface. You can 
configure, measure, and control the instrument either locally or remotely using this interface.

You can also use the Measurement Framework application that is provided with the 
instrument, if desired, to verify the operation of your instrument; refer to the documentation 
provided with the Measurement Framework application for more information.

This chapter focuses on verifying your instrument using the web interface.

Note: DT8871, DT8871U, DT8872, and DT8873 instruments with firmware version 2.2.3.1 or 
greater are identified in firmware as DT8874-xxT-xxR-xx-V, where xxT specifies the number 
of thermocouple channels, xxR specifies the number of RTD channels, and xxV specifies the 
number of voltage input channels.

Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals
(see Chapter 4 starting on page 47)

Verify the Operation of the Instrument
(this chapter)

Prepare to Use the Instrument
(see Chapter 2 starting on page 29)



Verifying the Operation of Your Instrument
Before Using the Web Interface
This section describes system requirements and browser settings for proper operation of the 
instrument’s web interface.

Note: At any instant, up to 8 clients can access the instrument concurrently using the web 
interface.

Up to 12 additional clients can access the instrument concurrently using SCPI commands 
over VISA or sockets. Of these, 4 can be VXI-11 clients, which use the ::SOCKETS or 
VISA::INSTR resource to access the instrument. 

At this time, the web and SCPI interfaces cannot be "locked;" therefore, one client can change 
the configuration of the instrument that another client is accessing. However, you can 
optionally lock the VXI-11 interface using the VISA APIs viLock/viUnlock; this prevents 
other VXI-11 clients (including VXI-11 discovery) from accessing the instrument. Refer to the 
SCPI documentation for your instrument for more information on supported SCPI 
commands.

Java Requirements

Before using the instrument web interface, ensure that your computer has Version 6, Update 5 
or greater of Java installed; this version of Java installs version 1.6 of the Java plug-in. You can 
verify Java versions and settings by accessing the Java Control Panel, select Windows Start -> 
Control Panel and open the Java dialog. To download or upgrade Java, go to www.java.com.

Internet Explorer Browser Settings

For proper operation of the instrument’s web interface, ensure that your Internet Explorer is 
configured as follows:

• JavaScript (Active Scripting) must be enabled

• Security level of the instrument’s IP address must be Medium-high or lower

• Pop-up blockers must be disabled

The following sections describe how to configure these settings.

JavaScript

To enable JavaScript (also referred to as Active Scripting), perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Select Internet, and then click Custom Level.

4. Scroll down to the Scripting section.
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5. Under Active Scripting, select Enable, and then click OK.

Security Levels

By default, the IP address of the instrument is added to the Internet zone. If you'd rather leave 
the settings of the Internet zone at a level higher than Medium-high, then you can add the IP 
address of the instrument to either the Local intranet or Trusted sites zone and configure the 
security level of that zone to Medium-high or lower.

The following section describe how to configure each zone.

Internet Zone

To configure the security level of the instrument module’s IP address in the Internet zone, 
perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.
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3. Select Internet and move the slide bar to select a security level of Medium-high or lower.

4. Click OK.

Local Intranet Zone

To add the IP address of the instrument to the Local intranet zone and configure its security 
level, do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Local intranet, and click Sites.

4. Select which web sites to add to the zone, and then click Advanced.

5. Enter the IP address of the instrument to the zone, and click Add.
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6. Click Close.

7. Move the slide bar to select a security level of Medium-high or lower.

8. Click OK.

Trusted Sites Zone

To add the instrument’s IP address to the Trusted sites zone and configure its security level, 
do the following:

To add the IP address of the instrument to the Trusted sites zone and configure its security 
level, do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Trusted sites, and click Sites.

4. Enter the IP address of the instrument to the zone (note that the address must be prefaced 
by (https://), and click Add.



Verifying the Operation of Your Instrument
5. Click Close.

6. Move the slide bar to select a security level of Medium-high or lower.

7. Click OK.

Pop-up Blockers

To disable pop-up blockers, perform the following steps:

1. From the Internet Explorer browser, select Tools ->Pop-up Blocker.

2. Select Turn Off Pop-up Blocker.
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Associating CSV Files with Microsoft Excel or Notepad

If files with the .CSV extension do not have the proper file associations/actions set up, then 
clicking Download in the Download Measurements page of the instrument web interface will 
not present the option of saving the data to a file or loading the data to an application, such as 
Microsoft Excel® or Microsoft® Notepad, that can display it. Instead, the data will be 
displayed in the browser. 

The following steps describe how to associate a CSV file with Microsoft Excel or Notepad in 
Windows XP; refer to the documentation for your operating system for more information:

1. From the Windows Control Panel, open the Folder Options dialog, and select File Types. 

2. Scroll down to the CSV entry and select it. (If it is not in the list add it as a new file type by 
selecting New and entering CSV).

3. Click Advanced to access the Edit File Type dialog box. 

4. Click New to access the New Action dialog box. 

5. Enter Open in the Action: edit field.

6. Click Browse and find Excel.exe (typically located in C:\Program Files\Microsoft 
Office\OFFICExx\EXCEL.EXE) or Notepad.exe (typically located in 
C:\Windows\Notepad.exe) on your system, and then click OK.

7. Click OK. 

Now when you click Download on the Download Measurements web page, you should see a 
dialog box asking if you want to Open or Save the data in the appropriate application.
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Locating Your Instrument on the LAN
To access the web interface of your instrument, you must determine its IP address on your 
TCP/IP network. 

Note: Discovery works only for devices on the same subnet.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with 
the instrument to locate your instrument on the network quickly. Alternatively, you can use 
other LXI discovery tools, such as Agilent Connection Expert, if you have them installed on 
your computer. Or you can check your router’s address assignments or locate the instrument’s 
MAC (Ethernet hardware) address in your DHCP server log.

Running the Eureka Discovery Utility 

To use the Eureka Discovery Utility, from the Windows Start menu, click Programs -> Data 
Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.
A screen similar to the one shown in Figure 31 appears.

Figure 31: Eureka LXI Discovery Utility

If you are having trouble seeing your instrument in this list, check your Windows firewall 
settings using the information in the next section; otherwise, skip this section and continue 
with “Launching the Web Interface” on page 82.
79



Chapter 5

80
Configuring Windows Firewall Settings

If you are having trouble seeing your instrument using the Eureka Discovery Utility, check 
your Windows firewall settings by doing the following:

1. Right click in the tile bar of the Eureka Discovery Utility.
The following menu options appear:

2. Click the Firewall Configuration... option.
The following window appears:
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3. On the left side of the window, select Turn Windows Firewall on or off, select Turn On 
Windows Firewall setting for proper operation of the Eureka Discovery Utility, and click 
OK.

4. On the left side of the window, select Allow a program or feature through Windows 
Firewall, ensure that Eureka LXI Instrument Discovery is included in the list of 
exceptions, and click OK.

5. If Eureka LXI Instrument Discovery is not included in the exception list, add the utility to 
the list of exceptions by doing the following:

a. Click Allow another program...

b. Browse to C:\Program Files\Data Translation\Instrument Support\Eureka.exe, 
and click Open.
The Eureka LXI Instrument Discovery utility appears in the window.

c. Click Add to add the utility to the list of exceptions.

d. Click OK to exit from the Windows Firewall Configuration menu.
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Launching the Web Interface

From the Eureka utility, double-click the appropriate IP address to open the web pages for 
your instrument using your default web browser. Alternatively, you can enter the IP address 
of your instrument directly in your Internet Explorer address bar to see the instrument’s web 
interface.

The main web page, similar to the following screen, shows information about your instrument 
on the network: 

 

If you have multiple instruments connected to the network, you can click "Turn ON front 
panel identification indicator" to light the LAN LED on the instrument, described on page 42, 
to indicate the device you are using.

To change the description, IP address, or time source associated with the instrument, click the 
Modify links to navigate to the LAN Configuration page, described on page 83.
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Configuring the Instrument
Web pages are provided for configuring the following aspects of your instrument: 

• Local Area Network (LAN) settings

• Channels that you want to measure

• Scan rate 

• Filter

• Alarm limits

• Digital I/O lines

LAN Configuration

Use the Configuration -> LAN web page to configure the Local Area Network (LAN) settings 
for the instrument. A screen similar to the following appears:

When you first access your instrument, the LAN settings that the instrument obtained 
through DHCP or AutoIP should be sufficient. If you need to make changes later, click the 
Modify button to enable changes. Contact your system administrator and view the 
instrument’s built-in help pages to determine the correct LAN settings.
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Note: If you want to assign a static IP address, ensure that you uncheck the checkbox called 
Automatic private IP address enabled.

When you click Modify, you must supply a password for the instrument. 

The username is admin; it cannot be changed. The default password is admin. You can change 
the password on this page. 

Note that the new password is saved in permanent memory in the instrument and goes into 
effect after the instrument reboots. If you are prompted for a password before the instrument 
reboots, you must enter your original password. The web interface, IVI-COM driver, and SCPI 
interface use the same password. You can also configure the password using the IVI-COM 
driver or through SCPI commands. 

You are prompted for this password any time the instrument’s configuration is changed or 
when an attempt is made to start or stop a scan. This mechanism relies on features in the 
HTTP standard to prevent unauthorized users from reconfiguring or operating the 
instrument. Note, however, that authentication is not required to view the instrument’s 
configuration or scan results.

Note: The DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments with firmware 
version 2.2.3.1 or greater use the default user name admin and the default password admin. 
Firmware version 2.2.3.1 and greater support password-protected commands. Therefore, you 
must enter the appropriate password to change the instrument’s configuration or to start and 
stop a scan.

If the firmware version for these instruments is less than 2.2.3.1, then the default user name is 
sysadmin and the default password is user. Firmware versions less than 2.2.3.1 do not 
support password-protected commands. Therefore, you are not prompted to enter a 
password to change the instrument’s configuration or to start or stop a scan.

Specify the time zone that is used by the instrument as an offset (either + or –) from GMT 
(Greenwich Mean Time). The specified hour and minute is added to the UTC (Coordinated 
Universal Time) time that is maintained by the instrument. For example choosing –5 hours, 0 
minutes sets the current time zone used by the instrument to five hours and 0 minutes behind 
GMT. 

Channel Configuration

Use the Configuration -> Channel web page to enable the channels that you want to measure, 
specify the sensor to use for each channel, and add a label to describe each channel, if desired. 
A screen similar to the following appears:



Verifying the Operation of Your Instrument
To change your channel configuration, do the following: 

1. Under Enable Channel, check the boxes next to the channels that you want to collect data. 
You can use the Enable All and Disable All buttons for quick configuration of many 
channels.

2. Under Type, select the sensor type for each configured channel from the drop-down list 
boxes. If all the channels are of the same type (thermocouple, RTD, or voltage), you can 
use the Set all button to change all channels to the sensor type specified in the heading’s 
drop-down list box.

3. Describe the channels, if desired, by entering text in the Label field corresponding to the 
channel that you want to describe. 

4. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Scan Rate

Use the Configuration -> Scan Rate web page to set the scan rate for all channels on the 
instrument. A screen similar to the following appears:

 

To change your instrument’s scan rate, do the following: 

1. Type a value, in Hertz, between the minimum and maximum shown in the Scan Rate 
field.

Note: The scan rate that you specify is rounded to the closest "correct" value that the 
instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in 
the range of 1 to 65535 (the internal clock divider) to determine the closest value. When 
you save the scan rate configuration, the actual scan rate is shown.

2. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.



Verifying the Operation of Your Instrument
Filter Configuration

Use the Configuration -> Filter web page to configure the filter type used by the instrument. 
A screen similar to the following appears:

You can choose one of the following filter types:

• Raw – No filter. Provides fast response times, but the data may be difficult to interpret. 
Use when you want to filter the data yourself.

The Raw filter type returns the data exactly as it comes out of the Delta-Sigma A/D 
converters. Note that Delta-Sigma converters provide substantial digital filtering above 
the Nyquist frequency.

Generally, the only time it is desirable to use the Raw filter setting is if you are using fast 
responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much 
response speed as possible.

• Moving average – (The default filter setting.) Provides a compromise of filter 
functionality and response time. This filter can be used in any application.

This low-pass filter takes the previous 16 samples, adds them together, and divides by 16. 
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Alarm Limits Configuration

Use the Configuration -> Limits web page to define alarm conditions for specific enabled 
channels that you want to measure. A screen similar to the following appears.

If the alarm condition occurs, the specified digital output line is turned on. 

To set up limit checking, do the following:

1. Under Limit, click the Enable buttons next to the channels for which you want to define 
limits. You can use the Disable All button to quickly stop limit checking on all channels. 
For each channel:

2. Enter a value in the Low Limit text box.

3. Enter a value in the High Limit text box.

4. (Optional) Select a Digital Output line to set from the drop-down list box for this channel. 
This line is set to 1 when the limit range (high or low) is exceeded. 

When multiple channels are configured to set a digital output line, a logical OR condition 
exists between them, and any value out of range sets the line to 1.

5. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.



Verifying the Operation of Your Instrument
You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.

Digital Input and Trigger Configuration

Use the Configuration -> Digital Input & Trigger web page to configure the digital input 
lines of your instrument:

To change your digital input configuration, do the following: 

1. Describe the digital input lines, if desired, by entering text in the Label field 
corresponding to the digital input line that you want to describe.

2. To enable use of an external, digital trigger on digital input line 0, click the Enable 
checkbox under the External trigger heading.

3. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Digital Output Configuration

Use the Configuration -> Digital Out web page to configure the digital output lines of your 
instrument:

To change your digital output configuration, do the following: 

1. Describe the digital output lines, if desired, by entering text in the Label field 
corresponding to the digital output line that you want to describe.

2. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Measuring Data and Controlling the Instrument
Use the Control web pages start or stop data acquisition on the sensor channels or to update 
the value of the digital output line.

Starting and Stopping a Scan

To start or stop a scan, use the Measurement & control -> Channel web page.

Press the Start scan button to begin acquiring data from the sensors. The measurements are 
displayed on the screen. Press the Stop scan button to stop acquiring data from the sensors. 

Notice the following aspects of the display:

• When acquiring data, the Start scan button changes to say Stop scan and the currently 
configured scan rate is displayed. 

• Each box on the Meter tab represents one of the analog input channels, in the same 
position as the physical connectors. 

• If you configured custom labels for some of the channels, those labels are shown here 
rather than the channel numbers. 

• Red boxes indicate that the value is out of range for the specified sensor type. 

• The values are updated only for the channels that you enabled, and at the scan rate you 
configured.
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Controlling the Digital Outputs

Use the Measurement & control -> Digital Output web page to view the current state of the 
digital output lines, and manually change them if desired. A screen similar to the following 
appears:

Green indicates that the digital output line/relay is closed; red indicates that the digital output 
line/relay is open.

Note: You cannot change the configuration of digital output lines that were configured for 
limit checking on the Configuration -> Limits page.

To change the status of a digital output line/relay, click the Open/Close toggle buttons under 
the Change State heading for the digital output lines that you want to change. You can use 
these controls to activate or deactivate an external device based on criteria other than 
temperature that you define.
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Reading the Digital Inputs

While the instrument is scanning, you can use the Measurement & control -> Digital Input 
web page to view the current value of the digital input port. A screen similar to the following 
appears:

If you configured custom labels for the digital input lines, those labels are shown here.

The Current state LEDs show green if the digital input line is on (relay is closed) or red if the 
digital input line is off (relay is open).
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Downloading Measurements

Note: Before using this feature, ensure that you have associated CSV files with Microsoft 
Excel or Notepad, described on page 78, or the data will be displayed in the browser and not 
saved to a file.

You can use the File -> Download Measurements web page to download your measurement 
results, including timestamp and limit values, if applicable, to disk. A screen similar to the 
following appears:

 

Measurements taken by the instrument are stored in a large circular buffer; when the buffer is 
full, the oldest data is overwritten with the most recent data. 

To download your data, do the following: 

1. Click the Download button on this page.

If scanning has been stopped, all the data in the buffer is downloaded to a 
comma-separated CSV file, starting with the most recent data.
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If scanning is in progress, a snapshot of the data from the most recent data (at the time 
that the Download button was clicked) to the oldest data in the buffer is downloaded to a 
comma-separated CSV file. 

2. In the resulting dialog box, choose Open or Save. 

− If you choose Open, the CSV file opens in the associated application (Microsoft Excel 
or Notepad). 

− If you choose Save, you can open the CSV file in Microsoft Excel, Notepad, or other 
utilities for analysis at a later time.

Under some circumstances, your data may be displayed in a frame in the browser, or Excel 
may open the data in the frame. Change your Microsoft Excel, Microsoft Explorer, and 
Internet Explorer settings to turn off these behaviors and open your files directly in Excel. 

Most Recent Data

Downloaded Data

Beginning of Buffer

Circular Buffer

End of Buffer

Most Recent Data

Oldest Data

Downloading Data

Beginning of Buffer End of Buffer

Circular Buffer
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Block Diagrams
This section includes the block diagrams for the DT8871U, DT8871, and DT8872 TEMPpoint 
instruments, DT8873 VOLTpoint instrument, and DT8874 MEASURpoint instruments.

DT8871U Block Diagram

Figure 32 shows the block diagram of the DT8871U TEMPpoint instrument.

Figure 32: Block Diagram of the DT8871U TEMPpoint Instrument
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DT8871 Block Diagram

Figure 33 shows the block diagram of the DT8871 instrument.

Figure 33: Block Diagram of the DT8871 TEMPpoint Instrument
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DT8872 Block Diagram

Figure 34 shows the block diagram of the DT8872 TEMPpoint instrument.

Figure 34: Block Diagram of the DT8872 TEMPpoint Instrument
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DT8873 Block Diagram

Figure 35 shows the block diagram of the DT8873 VOLTpoint instrument.

Figure 35: Block Diagram of the DT8873 VOLTpoint Instrument
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DT8874 Block Diagram

Figure 36 shows the block diagram of the DT8874 MEASURpoint instrument.

Figure 36: Block Diagram of the DT8874 MEASURpoint Instrument
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Analog Input Features
This section describes the following features of the analog input (A/D) subsystem on 
TEMPpoint, VOLTpoint, and MEASURpoint instruments:

• Analog input channels, described on this page

• Input ranges, described on page 108

• Resolution, described on page 110

• Calibration, described on page 110

• Sample clock, described on page 111

• Trigger source, described on page 111

• Conversion modes, described on page 112

• Filtering, described on page 114

• Data format, described on page 114 

• Error conditions, described on page 115 

Analog Input Channels

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide up to 48 analog input 
channels. The number of channels and the channel types supported (thermocouple, RTD, or 
voltage input) depend on the specific instrument model you purchased, as shown in Table 3.

Table 3: Number and Type of Analog Input Channels 

Instrument 
Type Models

# of Analog Input 
Channels Channel Types

TEMPpoint DT8871U-8 and DT8871-8 8 8 thermocouple inputs (numbered 0 to 7)

DT8871U-16 and DT8871-16 16 16 thermocouple inputs (numbered 0 to 15)

DT8871U-24 and DT8871-24 24 24 thermocouple inputs (numbered 0 to 23)

DT8871U-32 and DT8871-32 32 32 thermocouple inputs (numbered 0 to 31)

DT8871U-40 and DT8871-40 40 40 thermocouple inputs (numbered 0 to 39)

DT8871U-48 and DT8871-48 48 48 thermocouple inputs (numbered 0 to 47)

DT8872-8 8 8 RTD inputs (numbered 0 to 7)

DT8872-16 16 16 RTD inputs (numbered 0 to 15)

DT8872-24 24 24 RTD inputs (numbered 0 to 23)

DT8872-32 32 32 RTD inputs (numbered 0 to 31)

DT8872-40 40 40 RTD inputs (numbered 0 to 39)

DT8872-48 48 48 RTD inputs (numbered 0 to 47)
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Thermocouple Input Channels

For channels that support thermocouples, you can attach a voltage input or any of the 
following thermocouple types in a mix and match fashion: B, E, J, K, N, R, S, and/or T. 

By default, these channels are configured for voltage inputs. You can specify the thermocouple 
types for channels over the LAN using the web interface, as described in “Channel 
Configuration” on page 84, in the QuickDAQ application, or by using an API call in your 
application program. You can also use standard SCPI commands over VISA or sockets, if 
desired.

Note: In a mix-and-match system, it is easy to accidentally mismatch the software and 
hardware configuration for a channel. Therefore, it is recommended that you pay particular 
attention when configuring channels, since the resultant errors may be not large enough to 
notice initially, but may be significantly larger than the accuracy specification for the 
instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer 
to page 112 for more information on specifying the channels for a scan.

Table 4 lists the supported measurement range for each thermocouple type. (Refer to page 108 
for information on the supported input range for voltage measurements.)

VOLTpoint DT8873-8 8 8 voltage inputs (numbered 0 to 7)

DT8873-16 16 16 voltage inputs (numbered 0 to 15)

DT8873-24 24 24 voltage inputs (numbered 0 to 23)

DT8873-32 32 32 voltage inputs (numbered 0 to 31)

DT8873-40 40 40 voltage inputs (numbered 0 to 39)

DT8873-48 48 48 voltage inputs (numbered 0 to 47)

MEASURpoint DT8874-16T-16R-16V 48 16 thermocouple inputs (numbered 0 to 15)

16 RTD inputs (numbered 16 to 31)

16 voltage inputs (numbered 32 to 47)

Table 3: Number and Type of Analog Input Channels  (cont.)

Instrument 
Type Models

# of Analog Input 
Channels Channel Types
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Refer to Appendix A for the thermocouple accuracy of thermocouple channels over the 
dynamic range of the instrument.

Cold Junction Compensation

Each thermocouple channel has its own cold-junction compensation (CJC) at the input. The 
software reads the value of the CJC input along with the value of the analog input channel 
and automatically corrects for errors based on the specified thermocouple type and the 
thermocouple linearization data stored in onboard ROM.

A separate multiplexed A/D is used to acquire all the CJC input values. The software takes 
care of correlating the CJC measurements with the analog input measurements.

Note: The software provides the option of returning CJC values in the data stream. This 
option is seldom used, but is provided if you want to implement your own temperature 
conversion algorithms in software when using continuous operations. Refer to page 114 for 
more information on this feature.

Open Thermocouple Detection

Break detection circuitry (+10 nA on the DT8871U and DT8874; +100 nA on the DT8871) is 
provided for thermocouple channels to ensure that open thermocouples are detected. The 
Open (OPN) LED on the rear panel lights when this condition occurs; see Figure 14 on page 44 
for the location of this LED.

Table 4: Supported Measurement Range for Each Thermocouple Type

Thermocouple 
Type

Supported Measurement Range

Minimum Maximum

B 250° C (482° F) 1820° C (3308° F)

E –200° C (–328° F) 1000° C (1832° F)

J –210° C (–346° F) 1200° C (2192° F)

K –200° C (–328° F) 1372° C (2502° F)

N –200° C (–328° F) 1300° C (2372° F)

R –50° C (–58° F) 1768° C (3214° F)

S –50° C (–58° F) 1768° C (3214° F)

T –200° C (–328° F)  400° C (752° F)
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In addition, the software returns the value SENSOR_IS_OPEN (99999 decimal) for any 
channel that was configured for a thermocouple input and has either an open thermocouple 
or no thermocouple connected to it. This value is returned anytime a voltage greater than 100 
mV is measure on the input, since this value is greater than any legitimate thermocouple 
voltage. 

If the channel is configured for a voltage input (not a thermocouple type), the Open (OPN) 
LED never lights and the SENSOR_IS_OPEN value is not returned. Instead, the voltage value 
is returned. If no input is connected to the channel, the software returns a value of 
approximately 0.7 V due to the open thermocouple detection pull-up circuit.

RTD Channels

For channels that support RTDs, you can attach a voltage input or any of the following RTD 
types in a mix and match fashion: Platinum 100 Ω (Pt100), Platinum 500 Ω (Pt500), or Platinum 
1000 Ω (Pt1000) RTD using an European alpha curve of 0.00385 or an American alpha curve of 
0.00392. The supported temperature measurement range for these RTD types is –200° C 
(–328° F) to 850° C (1562° F). You can also measure a resistance value between 0 and 4k Ohms, 
if desired. (Refer to page 108 for information on the supported input range for voltage 
measurements.)

By default, all channels are configured for voltage inputs. You can specify the RTD types for 
channels over the LAN using the web interface, as described in “Channel Configuration” on 
page 84, in the QuickDAQ application, or by using an API call in your application program. 
You can also use standard SCPI commands over VISA, if desired.

Note: In a mix-and-match system, it is easy to accidentally mismatch the software and 
hardware configuration for a channel. Therefore, it is recommended that you pay particular 
attention when configuring channels, since the resultant errors may be not large enough to 
notice initially, but may be significantly larger than the accuracy specification for the 
instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer 
to page 112 for more information on specifying the channels for a scan.

Input Ranges

The input voltage range that is supported by your TEMPpoint, VOLTpoint, or MEASURpoint 
instrument depends on the specific instrument model that you purchased, as shown in Table 
5.
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Out of Range Data for Thermocouple Channels

Each thermocouple type corresponds to an allowable voltage range. If a voltage is measured 
on the input that is outside of the legal range for the selected thermocouple type, the channel 
may be configured for the wrong type of thermocouple or something other than a 
thermocouple may be connected to the channel.

For channels configured with a thermocouple type of None (voltage), the Limit (LMT) LED on 
the rear panel of the instrument lights to alert you when the voltage is out of range; see Figure 
14 on page 44 for the location of this LED. 

For channels configured with a thermocouple type other than None (voltage), the LMT LED 
lights when the temperature limit is out of range for the specified thermocouple type.

In addition, if the input voltage is less than the legal voltage range for the selected 
thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888 
decimal). If the input voltage is greater than the legal voltage range for the selected 
thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_HIGH (88888 
decimal).

Note: If you are continuously measuring from a properly configured thermocouple input 
channel and the thermocouple opens or becomes disconnected, the open thermocouple 
pull-up circuit causes the input voltage to rise to approximately 0.7 V over a few seconds.

In this case, the temperature value rises very quickly, and you will receive the 
TEMP_OUT_OF_RANGE_HIGH (88888 decimal) value followed by the OPEN_SENSOR 
(99999 decimal) value. In this case, the OPN LED lights when the open thermocouple is 
detected and the LMT LED lights when the temperature limit is out of range for the 
thermocouple type.

Table 5: Supported Input Ranges 

Instrument 
Type Models Input Range

TEMPpoint DT8871U ±0.75 V for all channels

DT8871 ±1.25 V for all channels

DT8872 ±1.25 V for all channels

VOLTpoint DT8873 ±10 V, ±100 V, or ±400 V 
(software-selectable for each channel)a

a. Older versions of this instrument had fixed input ranges of ±10 V, ±100 V, or ±400 V, depending on 
the model purchased.

MEASURpoint DT8874-16T-16R-16V ±0.75 V for channels 0 to 15;
±1.25 V for channels 15 to 31; 
±10 V, ±100 V, or ±400 V for channels 32 to 47 
(software-selectable for each channel)
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Out of Range Data for RTD Channels

Each RTD type corresponds to an allowable voltage range. If a voltage is measured on the 
input that is outside of the legal range for the selected RTD type, the channel may be 
configured for the wrong type of RTD or something other than an RTD may be connected to 
the channel.

For channels configured with a RTD type of voltage, the Limit (LMT) LED on the rear panel of 
the instrument lights to alert you when the voltage is out of range (greater than +1.25 V or less 
than –1.25 V); see page 44 for the location of this LED. For channels configured with an RTD 
type other than voltage, the LMT LED lights when the temperature limit is out of range for the 
specified RTD type.

In addition, if the input voltage is less than the legal voltage range for the selected RTD type, 
the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888.0 decimal). If the 
input voltage is greater than the legal voltage range for the selected RTD type, the software 
returns the value TEMP_OUT_OF_RANGE_HIGH (88888.0 decimal). 

Out of Range Data for Voltage Channels

Each voltage input channel has an allowable voltage range (±10 V, ±100 V, or ±400 V). You 
configure the input range for each channel using software. If a voltage is measured on the 
input that is outside of the legal range for that channel, the Limit (LMT) LED on the rear panel 
of the instrument lights to alert you; see page 44 for the location of this LED. 

Resolution

TEMPpoint, VOLTpoint, and MEASURpoint instruments support a resolution of 24 bits for 
the analog input subsystem; you cannot specify the resolution in software.

Calibration

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument is factory-calibrated to meet or 
exceed its published specifications using standards traceable to NIST.

The calibration process includes multiple steps. First, the A/D on each channel is calibrated 
for offset and gain; these values (including the zero point) are stored in ROM. Then, each CJC 
circuit is calibrated for thermocouple input channels, and the reference current is 
characterized for RTD channels.

While each instrument was designed to preserve high accuracy measurements over time, it is 
recommended that your instrument be recalibrated every year to ensure that it meets or 
exceeds specifications.

You can calibrate your instrument in the field using precise calibration equipment and the 
Measurement Instrument Calibration Utility. Refer to the help file for the Measurement 
Instrument Calibration Utility for detailed information.
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Optionally, you can return your instrument to Data Translation for recalibration. For 
information on factory recalibration, contact Data Translation at 508-481-3700, ext. 1323 (if you 
are in the USA) or call your local distributor (if you are located outside the USA); see our web 
site (www.datatranslation.com) for the name and telephone number of your nearest 
distributor.

In addition, each instrument auto-calibrates on each power-up cycle to guarantee 
high-accuracy measurements. This process, also known as auto-zeroing, resets the zero point 
of each A/D. You can also auto-calibrate the instrument at any time (as long as acquisition is 
not in progress) using a software command. Refer to your software documentation for more 
information on the auto-calibration feature.

Sample Clock Source

TEMPpoint, VOLTpoint, and MEASURpoint instruments support an internal clock with a 
maximum sampling rate of 10 Samples/s.

Use software to specify an internal clock source and a clock frequency between 
0.000152590219 Hz and 10.0 Hz. 

Note: The clock frequency that you specify is rounded to the closest "correct" value that the 
instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in 
the range of 1 to 65535 (the internal clock divider) to determine the closest value. Using 
software, you can query this setting to determine the actual clock frequency that is used.

When the continuous operation is started, all the channels specified in the channel list are read 
simultaneously at the specified clock frequency.

Trigger Source

A trigger is an event that occurs based on a specified set of conditions. Acquisition starts when 
the instrument detects the initial trigger event and stops when you stop the operation. 

TEMPpoint, VOLTpoint, and MEASURpoint instruments support the following trigger 
sources for starting analog input operations:

• Software trigger – A software trigger event occurs when you start the analog input 
operation (the computer issues a write to the instrument to begin conversions). 

• External digital trigger – An external digital trigger event occurs when the instrument 
detects a voltage from +3 V to +28 V DC on digital input line 0. Initially, the external 
signal must be low and then go high for at least 100 ms to be detected as a trigger. Once 
triggered, the state of digital input 0 is ignored. 
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Conversion Modes

TEMPpoint, VOLTpoint, and MEASURpoint instruments support simultaneous single value 
and continuous scan conversion modes for reading input measurements.

This section describes each of these conversion modes.

Simultaneous Single-Value Operations

If you want a snapshot of all the analog input channels at one point in time, you can perform a 
simultaneous single-value operation, also called a single values operation, using SCPI 
commands. 

Note: This operation mode is supported in SCPI only; it is not supported by the IVI-COM 
driver or the instrument’s web interface.

Use one of the :MEASure SCPI commands to specify the channels that you want to sample 
and the configuration of the channels, if needed. One single value is then acquired from each 
analog input channel simultaneously and returned.

If you need to continuously acquire data from one or more channels use continuous scan 
mode, described next, instead.

Continuous Scan Mode

Continuous scan mode takes full advantage of the capabilities of the TEMPpoint, VOLTpoint, 
and MEASURpoint instruments. Use continuous scan mode if you want to accurately control 
the period between successive simultaneous conversions of specific channels.

In addition to the analog input channels, this conversion mode allows you to read the digital 
input port (all 8 digital input lines) as part of the analog input data stream. This feature is 
particularly useful when you want to correlate the timing of analog and digital events. 

Specifying Analog Input Channels

Using software, enable the analog input channels that you want to sample by specifying the 
channel numbers in the channel list. You can also read the value of the digital input port 
through the analog input data stream by specifying the digital input channel in the channel 
list; the number of the digital input channel depends on how many channels the TEMPpoint, 
VOLTpoint, or MEASURpoint instrument provides, as shown in Table 6.
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The channels are read in order from the lowest channel number to the highest channel 
number in the list of enabled channels; this process is known as a scan.

How Continuous Scan Works

When you issue a command to start the scan, the instrument simultaneously samples all the 
analog input channels, CJC inputs (if applicable), and the digital input port, and converts the 
analog inputs to temperature, resistance, or voltage based on the sensor type. If the channel is 
enabled, the sampled data is placed in the FIFO on the instrument.

The FIFO on the instrument is used as a circular buffer. Acquisition continues indefinitely 
until you stop the operation. When the FIFO is full, the operation wraps to the beginning of 
the FIFO; values are overwritten starting at the first location in the FIFO. It is up to your 
application to retrieve the data from the FIFO; refer to your software documentation for more 
information.

The conversion rate is determined by the frequency of the input sample clock; refer to page 
111 for more information about the input sample clock. The sample rate, which is the rate at 
which a single entry in the channel list is sampled, is the same as the conversion rate due to 
the simultaneous nature of the MEASURpoint instrument. 

Figure 37 illustrates scanning a list of three enabled channels: channel 0, channel 1, and 
channel 2. In this example, analog input data is acquired simultaneously on each clock pulse 
of the input sample clock. Data is acquired continuously.

Figure 37: Continuous Scan Mode

Table 6: Supported Channels for Continuous Operations

Total Number of
Analog Input Channels

Channel for Reading 
the Digital Input Port

 0 to 7 8

0 to 15 16

0 to 23 24

 0 to 31 32

0 to 39 40

0 to 47 48

Operation starts

Chan 0

Chan 1

Chan 2

Input 
Sample 
Clock

Data is acquired continuously

Chan 0

Chan 1

Chan 2

Chan 0

Chan 1

Chan 2

Chan 0

Chan 1

Chan 2
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Filtering

TEMPpoint, VOLTpoint, and MEASURpoint instruments use a Delta-Sigma analog-to-digital 
converter (ADC) for each analog input channel to provide simultaneous sampling of all 
inputs. The Delta-Sigma converter operates at 10 Hz effectively providing a filter that rejects 
50 Hz and 60 Hz power line frequency components and that removes aliasing, a condition 
where high frequency input components erroneously appear as lower frequencies after 
sampling.

In addition to the filter provided in hardware, you can further reduce noise by selecting one of 
the following filter options in software: Moving Average or Raw. Refer to page 87 and to your 
software documentation for more information on selecting a filter type.

Data Format

TEMPpoint, VOLTpoint, and MEASURpoint instruments return data as 32-bit floating-point 
values. How the data is returned depends on the channel type, as described in the following 
subsections. 

Data Format for Thermocouple Channels

If you specify a thermocouple type of None for a thermocouple input channel, a voltage 
measurement is selected and the instrument returns a voltage value. For the DT8871U and 
DT8874 instruments, the value is in the range of ±0.075 V; for the DT8872 instrument, the 
value is in the range of ±1.25 V. For all other thermocouple types, a temperature value, in 
degrees C, or one of the error constants, described on page 115, is returned.

In normal operation, one floating-point value is returned for each enabled channel (including 
the digital input port). If you enable the capability of returning CJC data in the data stream, 
described on page 107, two floating-point values are returned in the data stream for each 
enabled analog input channel. The first value in the pair represents the temperature (or 
voltage) of the channel; the second value in the pair represents the CJC temperature (in 
degrees C) for that channel.

Data Format for RTD Channels

If you specify an RTD type of None for an RTD input channel, a voltage measurement is 
selected and the instrument returns a voltage value in the range of ±1.25 V. If you specify an 
RTD type of Ohms, a resistance value is returned. For all other RTD types, a temperature 
value, in degrees C, or one of the error constants, described on page 115, is returned.

One floating-point value is returned for each enabled channel (including the digital input 
port).

Data Format for Voltage Channels

For voltage channels, a voltage value in the range of ±10 V, ±100 V, or ±400 V is returned, 
depending on how the channel was configured.
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One floating-point value is returned for each enabled channel (including the digital input 
port).

Error Conditions

TEMPpoint, VOLTpoint, and MEASURpoint instruments report overrun errors by sending an 
overrun event to the application program. If this error condition occurs, the instrument stops 
acquiring and transferring data to the host computer. To avoid this error, try one or more of 
the following:

• Reduce the sample rate 

• Close any other applications that are running

• Run the program on a faster computer 

Additionally, the following constants may be reported to the host:

• 99999.0 – SENSOR_IS_OPEN, described on page 107

• 88888.0 – TEMP_OUT_OF_RANGE_HIGH, described on page 109 and page 110

• –88888.0 – TEMP_OUT_OF_RANGE_LOW, described on page 109 and page 110

If any of these constants is reported, the A/D subsystem continues to acquire data; the error 
condition is cleared when the data falls within range.
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Digital I/O Features
TEMPpoint, VOLTpoint, and MEASURpoint instruments provide 8 digital input lines and 8 
digital output lines that you can use to control external equipment, including solid-state or 
mechanical relays. 

This section describes the following digital I/O features:

• Digital input lines, described below

• Digital output lines, described on page 117

• Channel-to-channel isolation, described on page 117

• Resolution, described on page 117

• Operation modes, described on page 117

Digital Input Lines

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, isolated, digital input 
lines.

Digital inputs operate from +3 to +28 V DC, with a switching time of 2 ms maximum. Figure 
38 shows the digital input circuitry; a 2.2 kΩ resistor is used in series with the LED in the 
opto-isolator input.

Figure 38: Digital Input Circuitry

A digital line is high (switch is closed) if its value is 1; a digital line is low (switch is open) if its 
value is 0. 

 

1 of 8 Opto-Isolators

Digital Input

+

-

2.2K



Principles of Operation
Digital Output Lines

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, latched and isolated 
digital output lines. The outputs are solid-state relays that operate at ±30 V and 400 mA peak 
(AC or DC). Switching time is 2 ms maximum. 

Figure 39 shows the digital output circuitry.

Figure 39: Digital Output Circuitry

Digital outputs resemble a switch; the switch is closed if the state of the digital output line is 1, 
and the switch is open if the state of the digital output line is 0. On power up or reset, the 
digital outputs are disabled. 

Channel-to-Channel Isolation

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument includes channel-to-channel 
isolation of up to 250 V between digital I/O lines. If you require greater channel-to-channel 
isolation, use every other digital line. This reduces the number of digital I/O lines, but 
provides channel-to-channel isolation of 500 V (one channel can be +250 V while the adjacent 
channel can be –250 V).

Resolution

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument provides 8 bits of resolution for 
the digital input port to accommodate the 8 digital input lines and 8 bits of resolution for the 
digital output port to accommodate the 8 digital output lines. These lines are organized as 
isolated, dedicated ports. You cannot configure port resolution through software. 

Operation Modes

Using software, you can read from a single digital input line or the entire digital input port, or 
write to a single digital output line or the entire digital output port. You can also return the 
value of the entire digital input port in the analog input data stream if you want to correlate 
analog input data with digital events; refer to page 112 for more information. 

 

1 of 8 Solid State Relays
117



Chapter 6

118



7
Troubleshooting

General Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

If Your Instrument Needs Factory Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
119



Chapter 7

120
General Checklist 
Should you experience problems using a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, do the following: 

1. Read all the documentation provided for your product, including any “Read This First” 
information.

2. Check the MEASURpoint Software CD for any README files and ensure that you have 
used the latest installation and configuration information available.

3. Check that your system meets the requirements stated in Chapter 2.

4. Check that you have installed your hardware properly using the instructions in Chapter 3.

5. Check that you have wired your signals properly using the instructions in Chapter 4. 

6. Check that you have installed Java and configured your web browser appropriately using 
the instructions on page 73.

7. Search the DT Knowledgebase in the Support section of the Data Translation web site (at 
www.datatranslation.com) for an answer to your problem.

If you still experience problems, try using the information in Table 7 to isolate and solve the 
problem. If you cannot identify the problem, refer to page 122. 

Table 7: Troubleshooting Problems 

Symptom Possible Cause Possible Solution

Instrument is 
not found.

The instrument cannot 
communicate with the 
network. 

Ensure that your instrument is properly connected; see the 
instructions in Chapter 3.

If your PC has a static IP address, reconfigure it for Auto-IP using 
the instructions on page 149.

Check your LAN configuration; see the instructions on page 83.

Check the IP address of the instrument by opening a Command 
Prompt window (Start -> Programs -> Accessories -> Command 
Prompt) and entering the command 
"ipconfig /all". The IP settings of your instrument are returned.

Ping the instrument by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and 
entering the command "ping address", where address is the IP 
address of your instrument. If a timeout message is returned, the 
IP address is incorrect. If a "no host" error message is returned, 
the subnet mask is incorrect. Refer to page 43 for more 
information on IP and subnet addresses.

If needed, reset the instrument using the instructions on page 46.



Troubleshooting
Instrument 
does not 
respond.

The instrument configuration 
is incorrect.

Check your LAN configuration; see the instructions on page 83.

Check the IP address of the instrument by opening a Command 
Prompt window (Start -> Programs -> Accessories -> Command 
Prompt) and entering the command "ipconfig /all". The IP settings 
of your instrument are returned.

Ping the instrument by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and 
entering the command "ping address", where address is the IP 
address of your instrument. If a timeout message is returned, the 
IP address is incorrect. If a "no host" error message is returned, 
the subnet mask is incorrect. Refer to page 43 for more 
information on IP and subnet addresses.

If needed, reset the instrument using the instructions on page 46.

The instrument is damaged. Contact Data Translation for technical support; refer to page 122.

Intermittent 
operation.

Loose connections or 
vibrations exist.

Check your wiring and tighten any loose connections or cushion 
vibration sources; see the instructions in Chapter 4.

The instrument is 
overheating.

Check environmental and ambient temperature; consult the 
specifications on page 140 of this manual and the documentation 
provided by your computer manufacturer for more information.

Electrical noise exists. Check your wiring and either provide better shielding or reroute 
unshielded wiring; see the instructions in Chapter 4.

Data appears 
to be invalid.

An open connection exists. Check your wiring and fix any open connections; see the 
instructions in Chapter 4.

A transducer is not connected 
to the channel being read.

Check the transducer connections; see the instructions in 
Chapter 4.

The thermocouple, RTD, or 
voltage input that you 
connected to the channel 
does not match the software 
configuration for that channel.

Check your wiring and ensure that what you specify in software 
matches your hardware configuration; see the instructions in 
Chapter 4.

Your instrument may need 
recalibration. 

The instrument is calibrated at the factory. Thereafter, yearly 
calibration is recommended. Use the Measurement Instrument 
Calibration Utility, described on page 23, or return your instrument 
to Data Translation for recalibration. 

For information on factory recalibration, contact Data Translation 
at 508-481-3700, ext. 1323 (if you are in the USA) of call your 
local distributor (if you are located outside the USA); see our web 
site (www.datatranslation.com) for the name and telephone 
number of your nearest distributor.

Table 7: Troubleshooting Problems  (cont.)

Symptom Possible Cause Possible Solution
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Technical Support 

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments have a 1 year warranty from 
the factory. If you open the instrument’s enclosure, you will void this warranty.

If you have difficulty using your TEMPpoint, VOLTpoint, or MEASURpoint instrument, Data 
Translation’s Technical Support Department is available to provide technical assistance. 

To request technical support, go to our web site at http://www.datatranslation.com and click 
on the Support link. 

When requesting technical support, be prepared to provide the following information:

• Your product serial number 

• The hardware/software product you need help on 

• The version of the MEASURpoint Software CD you are using 

• Your contract number, if applicable 

If you are located outside the USA, contact your local distributor; see our web site 
(www.datatranslation.com) for the name and telephone number of your nearest distributor.



Troubleshooting
If Your Instrument Needs Factory Service 
If your TEMPpoint, VOLTpoint, or MEASURpoint instrument must be returned to Data 
Translation, do the following: 

1. Record the instrument’s serial number, and then contact the Customer Service 
Department at (508) 481-3700, ext. 1323 (if you are in the USA) and obtain a Return 
Material Authorization (RMA).

If you are located outside the USA, call your local distributor for authorization and 
shipping instructions; see our web site (www.datatranslation.com) for the name and 
telephone number of your nearest distributor. All return shipments to Data Translation 
must be marked with the correct RMA number to ensure proper processing.

2. Using the original packing materials, if available, package the instrument as follows:

− Wrap the instrument in an electrically conductive plastic material. Handle with 
ground protection. A static discharge can destroy components on the instrument.

− Place in a secure shipping container. 

3. Return the instrument to the following address, making sure the RMA number is visible 
on the outside of the box.

Customer Service Dept.
Data Translation, Inc.
100 Locke Drive
Marlboro, MA 01752-1192
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Basic Instrument Specifications
Table 8 lists the basic instrument specifications for the DT8871, DT8871U, DT8872, DT8873, 
and DT8874 instruments. 

Table 8: Basic Instrument Specifications 

Feature Specifications

Number of channels in channel list Up to 48 analog input channels and one digital input port

A/D converter type High stability 24-bit Sigma-Delta



Specifications
Thermocouple Specifications
Table 9 lists the specifications for thermocouple channels on the DT8871, DT8871U, and 
DT8874 instruments.

Table 9: Thermocouple Specifications

Feature Specifications

Thermocouple types (software-selectable) B, E, J, K, N, R, S, T

A/D resolution 24-bits

Sample rate 10 Samples/s

Thermal disturbance channel-to-channel None

Upscale break detection current
DT8871U and DT8874:
DT8871:

+10 nA
+100 nA

System temperature error
DT8871U and DT8874:
DT8871:

See Table 10 and Table 11 on page 128
See Table 12 on page 130
127



Appendix A

128
System Temperature Error for the DT8871U and DT8874

Table 10 lists the typical accuracy of the DT8871U and DT8874 for each thermocouple type at 
several temperature points over the dynamic range of the instrument.

Table 11 lists the maximum accuracy of the DT8871U and DT8874 for each thermocouple type 
at several temperature points over the dynamic range of the instrument.

Table 10: Typical Thermocouple Accuracy of the DT8871U and DT8874

Input
Temp.

Thermocouple Typea

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Inclusive of typical 0.15°C CJC error. Exclusive of thermocouple 
errors.

J K T E S R B N

–100° C ±0.17°C ±0.17°C ±0.16°C ±0.16°C ----------- ----------- ----------- ±0.16°C

0° C ±0.15°C ±0.16°C ±0.16°C ±0.15°C ±0.20°C ±0.20°C ----------- ±0.16°C

100° C ±0.18°C ±0.15°C ±0.16°C ±0.15°C ±0.18°C ±0.18°C ----------- ±0.15°C

300° C ±0.15°C ±0.17°C ±0.16°C ±0.15°C ±0.18°C ±0.18°C ±0.23°C ±0.15°C

500° C ±0.15°C ±0.15°C ----------- ±0.15°C ±0.18°C ±0.17°C ±0.21°C ±0.15°C

700° C ±0.15°C ±0.15°C ----------- ±0.16°C ±0.18°C ±0.18°C ±0.17°C ±0.16°C

900° C ±0.15°C ±0.17°C ----------- ±0.17°C ±0.18°C ±0.18°C ±0.19°C ±0.16°C

1100° C ±0.15°C ±0.16°C ----------- ----------- ±0.19°C ±0.18°C ±0.18°C ±0.16°C

1400° C ----------- ----------- ----------- ----------- ±0.18°C ±0.18°C ±0.17°C -----------

Table 11: Maximum Thermocouple Accuracy of the DT8871U and DT8874

Input
Temp.

Thermocouple Typea

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Maximum accuracy inclusive of 0.25°C CJC error. Exclusive of 
thermocouple errors.

J K T E S R B N

–100° C ±0.35°C ±0.38°C ±0.39°C ±0.34°C ----------- ----------- ----------- ±0.43°C

0° C ±0.33°C ±0.35°C ±0.35°C ±0.32°C ±0.96°C ±0.98°C ----------- ±0.40°C

100° C ±0.34°C ±0.31°C ±0.34°C ±0.31°C ±0.77°C ±0.76°C ----------- ±0.37°C

300° C ±0.31°C ±0.36°C ±0.32°C ±0.30°C ±0.67°C ±0.65°C ±1.52°C ±0.35°C

500° C ±0.30°C ±0.33°C ----------- ±0.30°C ±0.64°C ±0.61°C ±1.02°C ±0.34°C

700° C ±0.30°C ±0.33°C ----------- ±0.31°C ±0.62°C ±0.58°C ±0.80°C ±0.35°C

900° C ±0.30°C ±0.36°C ----------- ±0.31°C ±0.60°C ±0.56°C ±0.72°C ±0.35°C

1100° C ±0.31°C ±0.35°C ----------- ----------- ±0.59°C ±0.54°C ±0.65°C ±0.35°C

1400° C ----------- ----------- ----------- ----------- ±0.57°C ±0.53°C ±0.59°C -----------



Specifications
The histograms shown in Figure 40 and Figure 41 characterize the Gaussian system noise 
distribution for each of the available filter types on the DT8871U and DT8874. Note that 
converting μV error to temperature error depends on thermocouple type. For example, a K 
thermocouple changes approximately 39 μV per degrees C; therefore, a noise level of 0.1 μV 
adds less than 0.003° C error (0.1 μV / 39 μV) for a type K thermocouple.

Figure 40: System Noise on the DT8871U and DT8874 Using No Software Filter (Raw Filter)

Figure 41: System Noise on the DT8871U and DT8874 Using the Moving Average Filter
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System Temperature Error for the DT8871

Table 12 lists the typical accuracy of the DT8871 for each thermocouple type at several 
temperature points over the dynamic range of the instrument.

 

The histograms shown in Figure 42 and Figure 43 characterize the Gaussian system noise 
distribution for each of the available filter types on the DT8871. Note that converting μV error 
to temperature error depends on thermocouple type. For example, a K thermocouple changes 
approximately 39 μV per degrees C; therefore, a noise level of 10 μV adds 0.3° C error 
(10 μV / 39 μV) for a type K thermocouple.

Table 12: Typical Thermocouple Accuracy of the DT8871 

Input
Temperature

Thermocouple Typea

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Inclusive of typical 0.2°C CJC error (maximum CJC error is 0.3°C). 
Exclusive of thermocouple errors.

J K T E S R B N

–100° C ±0.33°C ±0.37°C ±0.38°C ±0.31°C ----------- ----------- ----------- ±0.44°C

0° C ±0.30°C ±0.33°C ±0.33°C ±0.28°C ±1.12°C ±1.14°C ----------- ±0.39°C

100° C ±0.31°C ±0.29°C ±0.31°C ±0.27°C ±0.88°C ±0.86°C ----------- ±0.35°C

300° C ±0.29°C ±0.34°C ±0.29°C ±0.26°C ±0.75°C ±0.71°C ±1.84°C ±0.33°C

500° C ±0.28°C ±0.31°C ----------- ±0.26°C ±0.71°C ±0.66°C ±1.20°C ±0.33°C

700° C ±0.27°C ±0.30°C ----------- ±0.27°C ±0.68°C ±0.63°C ±0.92°C ±0.33°C

900° C ±0.27°C ±0.34°C ----------- ±0.28°C ±0.66°C ±0.60°C ±0.80°C ±0.33°C

1100° C ±0.28°C ±0.34°C ----------- ----------- ±0.64°C ±0.58°C ±0.71°C ±0.34°C

1400° C ----------- ----------- ----------- ----------- ±0.62°C ±0.56°C ±0.64°C -----------



Specifications
Figure 42: System Noise on the DT8871 Using No Software Filter (Raw Filter)

Figure 43: System Noise on the DT8871 Using the Moving Average Filter
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RTD Specifications 
Table 13 lists the specifications for RTD channels on the DT8872 and DT8874 instruments.

Table 14 lists the RTD alpha curves that are supported by RTD channels.

Table 13: RTD Specifications 

Feature Specifications

RTD types (software-selectable) Platinum 100 Ω, 500 Ω, and 1000 Ω 

A/D converter resolution 24-bits

Sample rate 10 Samples/s 

Supported temperature range –200 to +850° C (European standard)

Current source
Absolute current:

Drift:

Drift per year:

425 μA, ±0.5% at 25° C (calibrated in firmware)

10 ppm/° C maximum

±100 ppm typical 

Internal reference +1.250 ±0.002 V

Thermal disturbance channel-to-channel None

Supported RTD alpha curves See Table 14

Table 14: Supported RTD Alpha Curves

Alpha (Average 
Temperature 
Coefficient of 

Resistance (/°C))

Nominal 
Resistance at 

0°C Organization Standard

0.00385 100 Ω British Standard BS1904: 1984

Deutschen Institut 
fur Normung

DIN 43760: 1980

0.00392 98.129 Ω Scientific Appartus 
Manufacturers of 
America

SAMA 
RC-4-1966
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Temperature Specifications
Table 15 lists the temperature specifications for thermocouple channels on the DT8871, 
DT8871U, and DT8874 instruments.

Table 15: Temperature Stability Specifications for Thermocouple Channels

Feature Specifications

Additional error due to ambient temperature 
changea

J-type thermocouple:
K-type thermocouple:
B-type thermocouple:
E-type thermocouple:
N-type thermocouple:
R-type thermocouple:
S-type thermocouple:
T-type thermocouple:

a. Includes the A/D reference, gain, and CJC errors.

0.010° C per degree ambient change, typical
0.011° C per degree ambient change, typical
0.014° C per degree ambient change, typical
0.010° C per degree ambient change, typical
0.011° C per degree ambient change, typical
0.012° C per degree ambient change, typical
0.012° C per degree ambient change, typical
0.010° C per degree ambient change, typical

MEASURpoint warm-up time 1 hour

CJC
Error (maximum):

Accuracy:

Drift per year:

±0.25° C

Corrected in ROM @ 25° C to zero error

±50 ppm typical
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Table 16 lists the temperature specifications for RTD channels on the DT8872 and DT8874 
instruments.

Table 16: Temperature Specifications for RTD Channels

Feature Specifications

System temperature errora

Pt100:

Pt500:

Pt1000:

a. Includes the A/D reference and gain errors.

Offset (typical): ±0.03° C
Offset (maximum): ±0.30° C
RMS noise: 0.03° C
Temperature resolution: 0.002° C
Maximum system error: ±0.80° Cb

Offset (typical): ±0.007° C
Offset (maximum): ±0.07° C
RMS noise: 0.007° C
Temperature resolution: 0.0004° C
Maximum system error: ±0.16° Cb

Offset (typical): ±0.003° C
Offset (maximum): ±0.03° C
RMS noise: 0.003° C
Temperature resolution: 0.0002° C
Maximum system error: ±0.08° Cb

b. Includes a maximum linearity error of 10 ppm and a calibration setup error of 10 ppm. Users must be 
aware that subtle resistor value tolerances and self-heating of the external calibration resistors contribute 
calibration setup errors.

Warm-up time
MEASURpoint:
RTD sensors and external calibration 

resistors:

1 hour

1 minute
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Voltage Measurement Specifications
Table 17 lists the voltage measurement specifications for the DT8871, DT8871U, DT8872, 
DT8873, and DT8874 instruments.

Table 17: Voltage Measurement Specifications 

Feature Specifications

Input voltage range (no compensation)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

±0.0750 V
±1.2500 V
±1.2500 V
±10 V, ±100 V, or ±400 Va

A/D converter resolution 24-bits

Voltage resolution
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

0.015 μV
0.3 μV
0.3 μV
1.2 μV for the ±10 V input range;
12 μV for the ±100 V input range;
48 μV for the ±400 V input range

Sample rate 10 Samples/s

Input impedance
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

5 MΩ typical
5 MΩ typical
> 100 MΩ 
> 1 MΩ (Power ON or OFF)

Input common mode voltage ±500 V

Common mode rejection @ 60 Hz and 50 Hz > 150 dB

Coupling DC

System linearity
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

±0.005%
±0.005%
±0.001%
±0.001%

System gain error (includes all noise sources; gain = 1)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

±0.00075% of full-scale range
±0.00075% of full-scale range
±0.00075% of full-scale range
±0.01% of reading

System zero error (includes all noise sources; 
no filter)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

0.25 μV RMS
5 μV RMS
±12 μV 
±300 μV for the ±10 V input range;
±2 mV for the ±100 V input range;
±8 mV for the ±400 V input range
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System drift error, zero
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

±0.02 μV/° C typical
±0.02 μV/° C typical
±0.10 μV/° C
±0.5 μV/° C for the ±10 V input range;
±5 μV/° C for the ±100 V input range;
±20 μV/° C for the ±400 V input range

System drift error, gain
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 voltage channels:

±4 ppm/° C
±4 ppm/° C
±10 ppm/° C
±15 ppm/° C

A/D reference 
Drift:
Drift per year:

±8 ppm/° C maximum
±100 ppm typical

Full-scale long-term stability
DT8871U and DT8874 thermocouple channels:

DT8871:

DT8872 and DT8874 RTD channels:

DT8873 and DT8874 voltage channels:

±100 ppm/year typical

±100 ppm/year typical

±0.05° C per year @ 0° C (±0.27° C 
per year @ full-scale temperature)

±100 ppm/year typical

MEASURpoint warm-up time 1 hour

a. You configure the input range for each channel using software.

Table 17: Voltage Measurement Specifications  (cont.)

Feature Specifications
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Isolation and Protection Specifications
Table 18 lists the isolation and protection specifications for the analog input subsystem on the 
DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

Table 18: Isolation and Protection Specifications 

Feature Specifications

DT8871U, DT8871, and DT8874 Thermocouple Channels Overvoltage 
Protection (Power On/Off)

Pin 2 referenced to pin 3:
Pin 2 and 3 referenced to earth ground:

±40 V
±500 V

DT8872 and DT8874 RTD Channels Overvoltage Protection (Power 
On/Off)

Pin 1 referenced to pin 4:
Pin 2 referenced to pin 4:
Pin 3 referenced to pin 4:
Pin 1, 2, or 3 referenced to earth ground:

±4 Va

±40 V
±20 V
±500 V

a. Determined by internal protection diodes to the power supply. No damage occurs if current is limited to 
±10 mA.

DT8873 and DT8874 Voltage Input Channels Overvoltage Protection 
(Power On/Off)

Pin 1 referenced to pin 3:
Pins 1 and 3 referenced to earth ground:

±600 V
±500 V

ESD protection per standard EN6100-4-2:2009 (see page 141 for more)
Arc:
Contact:

8 kV
4 kV

Isolation voltage to the host computer ±500 V

Channel-to-channel isolation ±500 V
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Memory Specifications
Table 19 lists the memory specifications for the analog input subsystem on the DT8871, 
DT8871U, DT8872, DT8873, and DT8874 instruments.

Table 19: Memory Specifications

Feature Specifications

Data memory onboard 4 MByte

For Data logger built in, maximum time
before old data is overwrittena

48 channels @ 10 Hz:
48 channels @ 1 Hz:
48 channels @ 0.1 Hz:

a. Assumes limit detection is off for all channels, and for thermocouple channels, 
assumes CJC data is not collected. If power fails, all temperature data in the 
system is lost. The channel input type and filter settings are still available after 
power on, but the channel and digital I/O labels and channel limits are lost.

30 minutes
5 hours
50 hours
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Digital I/O Specifications
Table 20 lists the specifications for the digital input (DIN) and digital output (DOUT) 
subsystems on the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments. 

Table 20: Digital I/O Specifications 

Feature Specifications

Number of digital I/O lines 16 (8 In, 8 Out)

Number of ports 2, 8-bit (1 In, 1 Out)

Inputs 
Input type: 
High input voltage: 
Low input voltage: 
High input current: 
Low input current: 
Termination 

DC
+3 to +28 V 
< +1.5 V
2.2 kΩ resistor to 1.2 V 
2.2 kΩ resistor to 1.2 V 
Series 2.2 kΩ 

Outputs 
Output type: 
Output driver: 
High output: 
Low output: 
Breakdown voltage: 
Contact impedance: 

Solid-state relay 
CMOS 
± 30 V 
0.4 V @ 400 mA 
± 60 V 
1 Ω 

Isolation voltage 
To computer ground: 
Channel to channel 

±500 V
±250 Va

a. Determined by the pin spacing in the 37-pin digital connector. For greater 
channel-to-channel isolation, use every other digital I/O line; using every 
other digital I/O line allows ±500 V isolation channel-to-channel.
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Power, Physical, and Environmental Specifications 
Table 21 lists the power, physical, and environmental specifications for the DT8871, DT8871U, 
DT8872, DT8873, and DT8874 instruments.

Table 21: Power, Physical, and Environmental Specifications 

Feature Specifications

External power requirements +5 V ±0.25V @ 2 A (0.9 mA typical)

Physical
Dimensions of enclosure:

Weight: 

88.14 (H) x 212.85 mm (W) x 211.43 mm (D)

1704 g 

Environmental
Operating temperature range:
Storage temperature range:
Relative humidity: 
Altitude:

0° C to 55° C
–25° C to 85° C
to 95%, noncondensing
up to 10,000 feet



Specifications
Regulatory Specifications
The DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments are CE-compliant. Table 22 
lists the regulatory specifications for the DT8871, DT8871U, DT8872, DT8873, and DT8874 
instruments.

Table 22: Regulatory Specifications 

Feature Specifications

Emissions (EMI) FCC Part 15, Class A
EN55011:2007 (Based on CISPR-11, 2003/A2, 2006)

Immunity EN61326-1:2006 
Electrical Equipment for Measurement, Control, and Laboratory Use

EMC Requirements
EN61000-4-2:2009
Electrostatic Discharge (ESD) 4 kV contact discharge,
8 kV air discharge, 4 kV horizontal and vertical coupling planes

EN61000-4-3:2006
Radiated electromagnetic fields, 3 V/m, 80 to 1000 MHz; 
3 V/m, 1.4 GHz to 2 GHz; 1 V/m, 2 GHz to 2.7 GHz

EN61000-4-4:2004
Electrical Fast Transient/Burst (EFT) 1 kV on data cables

EN61000-4-6:2009
Conducted immunity requirements, 3 Vrms on data cables
150 kHz to 80 MHz

RoHS (EU Directive 2002/95/EG) Compliant (as of July 1st, 2006)
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Connector Specifications
This section lists the specifications for the following connector types:

• Thermocouple connectors

• RTD connectors

• Voltage connectors

• Ethernet connector

Thermocouple Connectors

Table 23 lists the specifications for the thermocouple connectors used on the DT8871, 
DT8871U, and DT8874 instruments.

Table 23: Thermocouple Connector Specifications 

Feature Specifications

Thermocouple jacks Omega plugs 

SMPW-U-M – For voltage measurements
SMPW-J-M – For J thermocouple type
SMPW-K-M – For K thermocouple type
SMPW-T-M – For T thermocouple type
SMPW-E-M – For E thermocouple type
SMPW-S-M – For S thermocouple type
SMPW-R-M – For R thermocouple type
SMPW-B-M – For B thermocouple type
SMPW-N-M – For N thermocouple type

Thermocouple connector Omega part# PCC-SMP-U-100-R-CE-ROHS

CAUTION:

When connecting inputs to the thermocouple connectors on a 
MEASURpoint or TEMPpoint instrument, it is highly recommended 
that you use only original Omega thermocouple plugs (SMPW), as 
connectors from other suppliers may not be equivalent mechanically.

If you use connectors from suppliers other than Omega, there is a 
risk that you may mechanically damage the thermocouple 
connectors on the MEASURpoint or TEMPpoint instrument.



Specifications
RTD Connectors

Table 24 lists the specifications for the RTD connectors used on the DT8872 and DT8874 
instruments.

Voltage Connectors

Table 25 lists the specifications for the voltage connectors used on the DT8873 and DT8874 
instruments.

Ethernet (RJ45) Connector

The Ethernet (RJ45) connector used on the DT8871, DT8871U, DT8872, DT8873, and DT8874 
instruments is shown in Figure 44.

Figure 44: Ethernet (RJ45) Connector

Table 24: RTD Connector Specifications 

Feature Specifications

4-Position screw terminal block header Phoenix Contact 1803293 

4-Position screw terminal block plug Phoenix Contact 1803594

Table 25: Voltage Connector Specifications 

Feature Specifications

4-Position screw terminal block header Phoenix Contact 1803293 

4-Position screw terminal block plug Phoenix Contact 1803594
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The pin assignments of this connector are described in Table 26:

Note: DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments do not support 
Auto-MDIX.

Table 26: Ethernet Connector Pin Assignments 

Pin Signal Name Description

1 TXD+ Transmit Data+

2 TXD− Transmit Data−

3 RXD+ Receive Data+

4 EPWR+ Power from Switch+

5 EPWR+ Power from Switch+

6 RXD− Receive Data−

7 EPWR− Power from Switch−

8 EPWR− Power from Switch−



Specifications
External Power Supply Specifications
Table 27 lists the specifications for the EP361 +5 V external power supply that is used with the 
DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

Table 27: External Power Supply (EP361) Specifications 

Feature Specifications

Type Total Power medical power supply (TPES22-050400 or 
TPEMG24-S050400-7)

Input voltage Typical 90 - 264 V AC 

Input current
TPES22-050400

TPEMG24-S050400-7

Typical 0.38 A at 115 V AC, 0.15 A at 230 V AC

Typical 0.347 A at 115 V AC, 0.215 A at 230 V AC

Frequency 47 to 63 Hz

Inrush current
TPES22-050400

TPEMG24-S050400-7

35 A at 230 V AC typical or less than 30 A by adding 
thermistor

6.274 A RMS at 230 V AC 

Output voltage 5 V DC

Output current 4.0 A

Output wattage
TPES22-050400

TPEMG24-S050400-7

Typical 22 - 24 W

Typical 20 - 24 W

Noise and ripple 1% peak to peak

Regulatory specifications
TPES22-050400

TPEMG24-S050400-7

UL, N, CE, FCC Class B

UL, ITE, CE, FCC Class B, Energy Star compliant
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Connector Pin Assignments
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Table 28 lists the pin assignments for the 37-pin digital I/O connector on TEMPpoint, 
VOLTpoint, and MEASURpoint instruments.

Table 28: Digital I/O Connector Pin Assignments

Pin Description Pin Description

1 Digital Input 0+ –

2 Digital Input 1+ 20 Digital Input 0–

3 Digital Input 2+ 21 Digital Input 1–

4 Digital Input 3+ 22 Digital Input 2–

5 Digital Input 4+ 23 Digital Input 3–

6 Digital Input 5+ 24 Digital Input 4–

7 Digital Input 6+ 25 Digital Input 5–

8 Digital Input 7+ 26 Digital Input 6–

9  Not Connected 27 Digital Input 7–

10 Digital Output 0 28 Not Connected

11 Digital Output 1 29 Digital Output 0

12 Digital Output 2 30 Digital Output 1

13 Digital Output 3 31 Digital Output 2

14 Digital Output 4 32 Digital Output 3

15 Digital Output 5 33 Digital Output 4

16 Digital Output 6 34 Digital Output 5

17 Digital Output 7 35 Digital Output 6

18 Not Connected 36 Digital Output 7

19 Not Connected 37 Not Connected
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Configuring the PC to Use Auto-IP
To set up the a TEMPpoint, VOLTpoint, or MEASURpoint instrument when the LAN does not 
support a DHCP server and your PC is configured to use a static IP address, you must 
temporarily reconfigure the PC to use Auto-IP by performing the following steps:

Note: This procedure may differ slightly depending on your computer and the version of 
Windows you are using. Windows XP instructions are shown here.

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). (If a TCP/IP 
selection is not listed, click Install, select Protocol, click Add, select the TCP/IP protocol, 
and click Install, and repeat step 3).



Configuring Network Settings on Your PC
4. IMPORTANT: Write down the IP address and subnet mask that is displayed! You will 
need this information later.

5. Select Obtain an IP address automatically, and then click OK.

6. Select the Alternate Configuration tab, and ensure that Automatic private IP address is 
selected.
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7. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt 
window. Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address



Configuring Network Settings on Your PC
Specifying a Static IP Address for your Instrument
To specify a static IP address for your TEMPpoint, VOLTpoint, or MEASURpoint instrument, 
use the LAN Configuration page of the web interface as follows:

1. From the LAN Configuration page, click Modify.

2. Specify the username as sysadmin, and specify the password (the default password is 
user). You can change the password, if you desire.

3. Uncheck the checkbox called Automatic private IP address enabled.

4. Click Static. 

5. Specify a static IP address for the instrument, so that is will be on the same subnet as your 
PC:

Note: You need a Simple Network Time Protocol (SNTP) time server on the LAN; 
otherwise, you need to provide a gateway. See your network administrator for more details.
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Reconfiguring the PC to Use a Static IP Address
After you have set up your instrument, you can reconfigure your PC to use a static IP address 
using this procedure:

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). 

4. Select Use the following IP address:, specify the static IP address and subnet mask that 
was initially assigned to the PC (see page 150), and click OK.

5. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt 
window. Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address
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ISO-Channel Technology
All TEMPpoint, VOLTpoint, and MEASURpoint products use ISO-Channel™ technology to 
eliminate common mode noise and ground loop problems.

This appendix includes two white papers that describe the benefits of using ISO-Channel 
technology.



About ISO-Channel Technology
Why ISO-Channel Technology is Your Best Return on 
Investment

When connecting signal sources to an instrument, it is important to eliminate the sources of 
error that can contribute to inaccuracies in your measurements. In most measurement 
instruments, this burden is on the customer. Instruments that use ISO-Channel technology, 
however, solve this problem for you – saving you tremendous setup and debug time and 
reducing costly grounding problems when connecting signals.

In today’s economy, we understand that every equipment decision needs to make good fiscal 
sense. This section describes why instruments with ISO-Channel technology offer you the best 
return on investment.

Understanding Ground Loops

When measuring signals, users often assume that the grounds of their signals and their 
measurement system are at the same potential. However, these ground potentials can differ 
by hundreds of millivolts.

If the difference in ground potential is large enough, current flows between the signal and 
your measurement system; this is called a ground loop (see Figure 45). Ground loops 
contribute noise that can greatly affect the accuracy of your measurements, especially when 
you are trying to measure low level signals precisely. Ground loop problems are the most 
common source of error in all measurements! Eliminating these errors, therefore, is critical 
when taking high accuracy measurements.

Figure 45: Measurement System with a Ground Loop

When a ground loop 
exists, the measured 
voltage, Vout, is the 
sum of the signal 
voltage, Vsource, and 
the ground potential 
difference, Vcm, which 
exists between the 
signal source ground 
and the measurement 
system ground. These 
errors often appear as 
transients or periodic 
signals in the 
measurement. For 
example, if a ground 
loop is formed with 50 
Hz or 60 Hz AC power 
lines, the unwanted AC 
signal appears as a 
periodic voltage error in 
the measurement.
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ISO-Channel Eliminates Ground Loops and Increases 
Common-Mode Rejection

ISO-Channel technology eliminates ground loop problems by using a differential, isolated, 
floating front-end. As you can see in Figure 46, a floating voltage signal is not referenced to 
system ground. 

Figure 46: Floating Signals

To measure floating signal sources, ISO-Channel technology uses differential analog input 
signals, a 24-bit Delta-Sigma A/D converter for each channel, and channel-to-channel 
isolation, as shown in Figure 47. 



About ISO-Channel Technology
Figure 47: ISO-Channel Technology

Floating, Differential Signals

ISO-Channel technology implements a virtually ideal differential measurement system that 
reads only the potential difference between the positive and negative terminals of the 
amplifier. For each channel, the differential signals are isolated in that they are referenced to a 
ground reference point that is not connected to earth ground. Ground loop problems are 
eliminated by ensuring that only one ground reference is used for each channel in the 
measurement system. The signal sources are isolated from each other and from the 
measurement instrument.
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Figure 48: Differential Signals and Common-Mode Voltage

When the measurement instrument and signal source are at different ground potentials, the 
difference in potential is called common-mode voltage. The measurement instrument cannot 
discern between the signal and the common-mode voltage believing that the sum of these 
voltages is the actual signal. Of course, the common-mode potential is simply an error.

ISO-Channel technology provides common-mode rejection of 150 dB, which contributes an 
almost imperceptible error (33.5 million to 1) to Vout. Compare this to traditional data 
acquisition measurement instruments, which typically provide only 80 dB of common-mode 
rejection and therefore, contribute much more error on the order of 1 part per 10,000. 

Simultaneous Architecture

Many measurement instruments on the market today provide multiplexed architectures, 
where one A/D is used to measure multiple channels. In this kind of architecture, if one 
channel goes down, all channels go down.

ISO-Channel technology, on the other hand, uses a simultaneous architecture, where each 
channel has its own dedicated 24-bit Delta-Sigma A/D, as shown in Figure 49.



About ISO-Channel Technology
Figure 49: Simultaneous vs. Multiplexed Architectures

Channel-to-Channel Isolation

Besides differential inputs, floating channels, and a simultaneous architecture, ISO-Channel 
technology provides channel-to-channel isolation, not just isolation from the analog front-end 
to the computer ground. With this kind of isolation, the channels are individually isolated 
from each other and from other system components. 

Typically, instrument manufacturers have used relays, isolation amplifiers, or optical isolation 
to provide channel-to-channel isolation. These methods have the following advantages and 
limitations:

• Relays – This technology provides good galvanic separation and can provide good 
accuracy and thermal properties, but relays are slow as they operate on one channel at a 
time (10 cycles/s), wear out over time, and are sensitive to magnetic fields. If one relay 
sticks, staying closed, the entire system fails! 

• Isolation amplifiers – Isolation amplifiers are used in multiplexed architectures. While 
they are solid-state, they are expensive, not as accurate, require more power, and generate 
more noise and heat than other solutions. 

• Optical isolation - Optical isolation is good in digital isolation systems but causes accuracy 
problems in analog isolation systems. It is also subject to long-term drift and requires 
considerably more power.

With ISO-Channel technology, the A/D is on the sensor side and has its own custom DC/DC 
converter. Then, optical or transformer isolation is used to transfer the A/D output data (the 
sensor data) digitally. And, due to the simultaneous architecture of ISO-Channel technology, 
all data is transferred in parallel.
161



Appendix D

162
Summary

ISO-Channel technology offers built in system redundancy to protect your investment - if one 
channel fails, the remaining channels are completely unaffected! Instruments with 
ISO-Channel technology also adapt to the sensors that they are connected to, allowing a 
different ground reference for each signal without introducing errors! For these key reasons, 
ISO-Channel technology protects against problems in the field, and thereby, reduces costs – 
what a great return on your investment.



About ISO-Channel Technology
Floating Signal Inputs Offer New Application 
Advantages

Precision measurement systems are often limited in that all inputs are connected to a single 
ground. Typically, multiplexer input configurations are set up this way, since all signal inputs 
are connected to the same return. Even differential input configurations use the same ground 
reference. The result is that accuracy and flexibility for accurate measurements can be severely 
compromised when noise or common mode voltage is present (see Figure 50).

Figure 50: In multiplexed systems, all inputs are connected to a signal ground, which can cause 
errors when noise or common mode voltage is present.

Crosstalk from one input signal can easily be reflected onto another input. The design 
movement to an A/D per channel can help this problem. But that is not sufficient in many 
cases (see Figure 51).
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Figure 51: Even when using an A/D per channel, noise can contribute errors to your measurement 
results.

To minimize noise and ground loops, some newer systems offer isolation between the input 
signal ground reference and the computer ground. This effectively separates the computer 
ground from the measurement portion of the system. But still, there is no isolation between 
input sensor channels, which is a common source of error and frustration for user 
applications. Why?

The assumption is made that all signal sources have the same exact ground reference. After 
all…ground is ground…isn’t it? Often this is not the case. For example, thermocouples for 
measuring temperature may be dispersed widely throughout an industrial setting, such as in 
the manufacture of air frames or in curing ovens. Grounds for these sensors may differ by 
several volts or even hundreds of volts. The resulting common mode voltage causes current to 
flow in the signal path, producing serious errors, which are very hard to diagnose and correct.

Isolating Each Input

Oftentimes it is NOT apparent that ground references from various sensors such as 
thermocouples, RTDs, strain gages, etc., are at different voltage potentials. Factors that can 
contribute to these ground differences are extensive wiring from long runs, crosstalk from 
motors or generators, or high source impedance from the signal source. Without recognizing 
this extraneous voltage, the measurement system “sees” this noise or common mode voltage 
as the actual signal. These unwanted noise sources lead to measurement errors (see Figure 52).



About ISO-Channel Technology
Figure 52: Common mode voltage is present when different ground potentials exist in your 
measurement system.

In many applications, noise is a fact and a common occurrence. To prevent this noise from 
entering the signal path, the signal must be isolated on a channel-to-channel basis as well as 
from the PC ground reference. 

Technology breakthroughs now allow channel-to-channel isolation to be accomplished 
effectively. Using an A/D per channel with a DC-DC converter for each A/D allows each 
signal input channel to be isolated from one another (see Figure 53). With this individual 
isolation per channel, each input channel can now “float” to its own ground reference. 
Separate channels are then effectively isolated from each other by the isolation barrier, up to 
±500 V for each channel. Now any noise or common mode voltage to that level is eliminated 
from the system measurement, allowing pristine results from each sensor without any 
interaction from any other sensor.
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Figure 53: An A/D per channel and a DC-to-DC converter for each A/D provides channel-to-channel 
isolation, where each signal can float to its own ground reference (±500 for the DT8874).

Input channel return references are effectively separate instruments when the inputs are 
isolated. This individual isolation now allows the ground reference of each channel to 
measure at the level of this common mode voltage, up to ±500 V. This capability allows some 
new application ideas to flourish.

Measurement of two signals, as shown in Figure 54, can now have essentially 3 separate 
ground references: each signal input (signal 0 and signal 1) has a separate return reference; 
additionally, the PC has a third ground reference. This scheme can be extended for many 
signal inputs, such as 48 inputs in a single small measurement box, for a total of 49 different 
ground references.



About ISO-Channel Technology
Figure 54: When measuring two input signals with channel-to-channel isolation, three ground 
references are provided (signal 0, signal 1, and PC ground).

New Application Derived from Isolated Channels

A typical application of measuring 48 channels of varying voltages from sensors, such as 
batteries, thermocouples, RTDs pressure sensors, etc., often must use different instruments 
because of the various ranges needed. Standard ranges of ±10 V may handle some 
applications, but not others, to the required resolution and accuracy.

With isolation per channel, combinations of channels can be used to measure higher voltage 
ranges. Figure 55 shows a configuration of 2 separate channels “ganged up” to measure a 
signal of up to 20 V. Normally each input would measure ±10 V. But, by using two identical 
channels, a range of twice that level can be accommodated. The output readings of each A/D 
are then summed to give the very accurate result. This is possible because the isolation 
between channels allows the return of the first channel to “float up” to a level halfway 
between the input signal. This reflects the accurate impedance balance of each input, and the 
high common mode rejection of each stage.
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Figure 55: Because each floating signal input is isolated from each other, you can use two separate 
channels, normally each configured for ±10V, to measure a ±20V signal. Simply sum the result of 

each channel to get your result.

Summary

When you need the highest accuracy and the most flexibility from your measurement system, 
ensure that floating signal inputs are provided. This approach allows noise-free 
measurements in tough industrial settings. It also saves countless days of tracking down 
erroneous readings that inevitably result if these precautions are not taken from the project’s 
beginning.
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